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5.3.0-TraceCompassTestCases Summary

New Bug Reports found Open Fixed Total
Bug Reports 0 0 0
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1.2
1.3
1.4
1.5

1.6

2.1

2.2
2.3
2.4
2.5
2.7

2.6

3.1

32
33
34
3.5
3.6

3.6

4.1

4.2

Section

Integration

Test Case

Verify C/C++ EPP Package RC1
Download EPP Package

Version of Tracing Features

TMF presence
LTTng presence

Network Tracepoint Analysis presence

2019-03 Update Site
Verify C/C++ EPP Package RC2

Download EPP Package

Version of Tracing Features

TMF presence
LTTng presence
GDB Tracepoint Analysis presence

PCAP/PCAPNG presence

2019-03 Update Site
Verify C/C++ EPP Package RC3
Download EPP Package

Version of Tracing Features

TMF presence
LTTng presence
GDB Tracepoint Analysis presence

Network Tracepoint Analysis presence

2019-03 Update Site
Verify C/C++ EPP Package RC4
Download EPP Package

Version of Tracing Features

Action

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installion Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Update site
"2019-03 - http://download.eclipse.org/staging/2019-
03/"

Download, extract and start EPP package. Check the

https://dev.eclipse.org/mailman/listinfo/epp-dev

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Open Network perspective
Go to Help -> Install New Software... -> Use the

testing update site "2019-03 - http://download.eclipse.

org/staging/2019-03/"

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Open Network Trace perspective
Go to Help -> Install New Software... -> Use the

testing update site "2019-03 - http://download.eclipse.

org/staging/2019-03/"

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details

Verification

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng, CTF, GDBTrace, PCAP/PCAPNG)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng, CTF, GDBTrace, PCAP/PCAPNG)

Tracing perspective opens
LTTng Kernel perspective
GDB Tracepoint analysis perspective

Network perspective opens

Verify that all LTTng Kernel, LTTng UST and GDB

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective
GDB Tracepoint analysis perspective

Network Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng Control, LTTng Kernel, LTTng UST, CTF,
GDBTrace)

To Do

Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass

Pass

N/A

N/A
N/A
N/A
N/A
N/A

N/A

N/A

N/A

Integration




5.3.0-TraceCompassTestCases

43
44
45

4.6

5.1

5.2

5.3

5.4

55

6.1

6.2

TMF presence
LTTng presence

GDB Tracepoint Analysis presence

_2019-03 Update Site

Verify Update Site

2019-03 Update Site

Trace Compass Update Site

Upgrade using 2019-03 Update Site

Upgrade using Trace Compass Update

Site

Upragde from previous EPP

.Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the

testing update site "2019-03 - http://download.eclipse.
~org/staging/2019-03/"

Download Eclipse for Committers and install LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network
Analysis from main simrel testing Update site
"2019-03 - http://download.eclipse.org/staging/2019-
03/"

Download Eclipse for Committers and install LTTng
Kernel, LTTng Control, LTTng UST, GDBTrace and
PCAP Network Analysis from the Linux Tools Update
site

http://download.eclipse.
org/tracecompass/photon/milestones

Download Eclipse for Committers from Photon.0 and
install LTTng, LTTng Kernel, GDBTrace and PCAP
Network Analysis from main simrel Update site.
http://download.eclipse.org/releases/photon

Try to update the installation using the testing simrel
update site.
http://download.eclipse.org/staging/2019-03/

Download Eclipse for Committers from Photon.0 and
install LTTng, LTTng Kernel, LTTng UST, GDBTrace

and PCAP Network Analysis from the Trace Compass

release Update site.
http://download.eclipse.org/tracecompass/releases/4.
3.0/repository

Try to update the installation using the Trace
Compass update site http://download.eclipse.
org/tracecompass/photon/milestones

Download Eclipse previous C/C++ EPP package. Try

to upgrade using both update sites:

(TODO find correct job: https://hudson.eclipse.
org/packaging/job/luna.epp-tycho-
build/128/artifact/org.eclipse.epp.
packages/archive/repository/)

"Mars - http://download.eclipse.
org/releases/maintenance”

The information about the update sites to use is

_usually posted on epp-dev

Rel outside rel train

Download Eclipse standard and install LTTng Kernel, L’
UST, GDBTrace and PCAP Network Analysis from ma

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Update site: http://download.eclipse.org/tracecompass/s Verify that installation was successful

Download Eclipse standard from Photon SR0O and
install LTTng, LTTng Kernel, LTTng UST, GDBTrace

and PCAP Network Analysis from the Trace Compass

update site:
http://download.eclipse.
org/tracecompass/stable/repository/

Verify that installation was successful

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

N/A
N/A
N/A

N/A

N/A

N/A

Integration



5.3.0-TraceCompassTestCases

Target: Ubuntu 12.04 64 bit and on Hudson

Section

Junit Tests

Step Test Case

1
1.1
1.2
1.3
1.4
1.5
1.6

1.10
1.11

Junit Test Cases

CTF Core Tests Plug-in

CTF Parser Tests Plug-in

State System Core Tests Plug-in
TMEF Core Tests Plug-in

TMF UI Tests Plug-in

TMF UI SWTBot Tests Plug-in

CTF Support for TMF SWTBot
Tests Plug-in

TMF Xml Analysis Core Tests Plug-

m

TMF Xml Analysis UI Tests Plug-in

LTTng Control Core Tests Plug-in

LTTng Control UI Tests Plug-in

LTTng Kernel Analysis Core Tests

Plug-in

LTTng Kernel Analysis UI Tests

Plug-in

LTTng Kernel Ul SWTBot Tests

Plug-in

LTTng Userspace Tracer Analysis

Core Test Plug-in

LTTng Userspace Tracer Analysis Ul

Test Plug-in

GDB Tracepoint Analysis Core Tests

Plug-in

GDB Tracepoint Analysis Ul Tests

Plug-in

Action

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins

Verification

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed

Fail

ToDo  Comment

D
Comment

Pass
Pass
Pass
Pass
Pass
Pass

Pass
Pass
Pass

Pass
Pass

Pass
Pass
Pass
Pass
Pass
Pass

Pass

JUnits
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Target:

1.1
1.2

2.1

22

2.3

3.1
32

33

34

35

3.6

3.7

3.8

3.9

3.10

4.1
4.2

4.3

44

4.5

4.6

Section
TMF - Histogram View

Test Case

Preparation

Step 1
Step 2

Manage View
Close view
Open view
Resize

Full Trace Histogram
Single selection
Range selection

Drag zoom window
Move zoom window

Set zoom window

Zoom in/out

Arrow keys

Home/End keys

Lost events

Zoom in/out (key)

Time Range Histogram
Single selection

Range selection

Drag zoom window

Zoom in/out

Arrow keys

Home/End keys

Action

Open and reset LTTng Kernel perspective
Open an LTTng trace

Close the Histogram View
Window > Show View > Tracing > Histogram

Resize the Histogram View width-wise

Select timestamp with left-click
Select time range with shift-left-click, shift-left-drag or left-drag

Drag the zoom window left/right with ctrl-left-drag or middle-drag
Move the zoom window with ctrl-left-click or middle-click

Set a new zoom window with right-drag

Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

With a trace containing lost events, click the "Hide lost events" toolbar

icon. Click it again.

Zoom in/out with +/- key

Select timestamp with left-click
Select time range with shift-left-click, shift-left-drag or left-drag

Drag the zoom window left/right with ctrl-left-drag or middle-drag

Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

Fail

Verification

LTTng Kernel perspective opens with
correct views

Views are populated

Histogram View is removed from
perspective

Histogram View is displayed and re-
populated

Histograms are compressed/decompressed
without loss

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated

Zoom window is dragged, won't go beyond
full range

Zoom window is centered on click, won't go
beyond full range

Zoom window is set, Window Span is
updated, won't go beyond histogram range

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection (blue bar) moves to the
previous/next non-empty bucket

Selection Start/End moves to beginning/end
of trace (i.e. start time of last bucket is
selected)

The lost events (red bars) are toggled on and
off.

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated
Zoom window is dragged, won't go beyond
full range

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection (blue bar) moves to the
previous/next non-empty bucket

Selection Start/End moves to beginning/end
of time range (i.e. start time of last bucket is
selected)

Type

SWTBot
SWTBot

SWTBot
SWTBot

SWTBot

Manual
Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

To Do

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

Comment

Tested with HistogramDataModelTest

End key goes to first event of last pixel

Won't exceed zoom window

84710

84710

HistogramView
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With a trace containing lost events, click the "Hide lost events" toolbar The lost events (red bars) are toggled on and
4.7 Lost events icon. Click it again. off. Manual

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
3.10  Zoom in/out (key) Zoom in/out with +/- key full trace range Manual

When TS is higher than selection end, those two values are switched so

5.1 Set selection start Enter a TS within the full range in Selection Start widget Selection Start + blue bars are updated Manual Selection Start < Selection End
‘When TS is lower than selection start, those two values are switched so
52 Set selection end Enter a TS within the full range in Selection End widget Selection End + blue bars are updated Manual Selection Start < Selection End
Select the link icon. Enter a TS within the full range in Selection Start
53 Set selection (linked) widget Selection Start/End + blue bars are updated Manual
54 Set invalid selection start Enter a TS before the full range start in Selection Start widget Selection Start + blue bar set to first event Manual
55 Set invalid selection end Enter a TS after the full range end in Selection End widget Selection End + blue bar set to last event Manual

6.1 Set window span Enter a span in Window Span widget Both Histograms are updated accordingly Manual

6.2 Set large window span Enter an invalid span (too large) in Window Span widget Span set to full range Manual

Enter an invalid span (too small, negative, not a number) in Window
6.3 Set invalid window span Span widget Span set to previous value Manual Span of 0.000 000 001 works, even though the minimum value should be 0.000 000 002

Time Range mouse Click on the time range histogram. The time of the bucket at the Other views are synchronized to the selected

7.1 synchronization mouse position is selected. time Manual
Full Trace mouse Click on the full trace histogram. The time of the bucket at the mouse  Other views are synchronized to the selected

7.2 synchronization position is selected. time Manual
Selection synchronization Select the link icon. Enter a time within the full range in Selection Other views are synchronized to the selected

73 (linked) Start widget time Manual

Selection Start/End + blue bars in both
7.4 External synchronization In any other view that supports time synchronization, select a time. histograms are updated to the selected time Manual

Time Range mouse Select a time range in the small histogram (shift-left click, left-drag or  Verify that the selected time range shows in

8.1 synchronization shift-left drag). both histograms, and in other views. Manual
Full Trace mouse Select a time range in the full histogram (shift-left click, left-drag, Verify that the selected time range shows in

8.2 synchronization shift-left drag). both histograms, and in other views. Manual
Selection Start/End Other views are synchronized to the selected

8.3 synchronization Enter a time within the full range in Selection Start/End widget time range Manual

Selection Start/End + blue bars in both
In any other view that supports time range synchronization, select a histograms are updated to the selected time
8.4 External synchronization time range. range Manual

Time Range mouse Select a zoom window in the small histogram (ctrl-left drag, middle- ~ Other views are synchronized to the new

9.1 synchronization drag, right-drag, mouse wheel up/down). range Manual
Full Trace mouse Select a zoom window in the full histogram (ctrl-left drag, middle- Other views are synchronized to the new

9.2 synchronization click, middle-drag, right-drag, mouse wheel up/down). range Manual
Window Span Other views are synchronized to the new

9.3 synchronization Enter a new span in Window Span widget range Manual

In any other view that supports range synchronization, select a new Window Span and both histograms are
9.4 External synchronization zoom window. updated to the new range Manual
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10

10.1

10.2

10.3

10.4

10.5

10.6
10.7

Multiple Trace
Synchronization

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)

Trace coloring
Close all traces

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-overlap-
testing

3) Import UST ${local}/traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

Select a time and new range

- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-click -> Follow time
updates from other traces

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click the
"Activate trace coloring” toolbar icon. Click it again.

Close all trace editor tabs

View shows the last opened trace

Selection Start/End, Window Span and both
histograms are updated to selected time and
new range.

View shows the last opened trace

Selection Start/End, Window Span and both
histograms are updated to selected time and
new range.

View is updated to show selected trace.
Selection Start/End, Window Span and both
histograms are set to the newly selected time
and range.

The colors in both Histograms and toggled
on and off. When it is toggled off, the
legend disappears at the bottom and only
one color is used for non-lost events.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual
SWTBot

HistogramView
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2.1

22
23

3.1
32

33

34

35

3.6

3.7

3.8

3.9

3.10

3.11

Section
TMF - Project View
Ubuntu 18.04 64 bit

Test Case

Preparation
Step 1

Step 2

Project Creation
New Project Wizard

Create project
Project structure

Traces Folder

Preparation
Traces Folder menu
Trace Import Wizard

Import single custom text trace (link to
workspace)

Import Single custom XML trace (link
to workspace)

Import LTTng Kernel CTF trace (link
to workspace)

Rename + copy import

Overwrite + copy import

Skip

Default overwrite

Import unrecognized

Import unrecognized (ignore)

Action

Open LTTng Kernel perspective

Open Navigator View (used for independent
verification)

Open New Tracing Project Wizard

Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and unzip
into a local directory ${local}

2) Import Custom Text and XML parsers
(ExampleCustomXmlIParser.xml,
ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from
the Manage Custom Parsers dialog.

Select the Traces folder and open its context menu
Select Import

1) Browse to directory $ {local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to
workspace" and

4) press Finish

redo 3.1-3.3 but this time select ExampleCustomXml.

xml

redo 3.1-3.3 but this time select directory kernel-
overlap-testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links
to workspace"

‘When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links
to workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links

to workspace"

‘When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links

to workspace" and select "Overwrite existing without

warning"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to
workspace" and

5) press Finish

redo 3.10, however unselect "Import unrecognized
traces"

Verification

LTTng perspective opens with correct views

Navigator View opens

Tracing Project Wizard opens

Tracing project appears in Project
Explorer/Navigator

Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)
Trace Import Wizard appears

Imported trace appear in Traces Folder and the
Trace Type Tmf Generic is set. Make sure trace
can be opened

Imported trace appear in Traces Folder and the
Trace Type "Custom XML log" is set. Make sure
that trace can be opened

Imported trace appear in Traces Folder and the
Trace Type "LTTng Kernel" is set. Make sure
that trace can be opened

Traces are imported with new name that has a
suffix (2) at the end. Make sure that imported
traces are copied to the project.

Existing traces are deleted and new traces are
imported. Make sure that imported traces are
copied to the project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for
renaming, overwriting, skipping) and existing
traces are overwritten). Make sure trace can be
opened

unrecognized.log is imported with trace type
unknown. The default text file icon is displayed.
The trace, when opened, is displayed in the text
editor.

unrecognized.log is not imported

Type

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

To Do

Comment

Comment

ProjectView
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Preparation

Import CTF trace by selection
312 metadata file only

Preparation

Recursive import with auto-detection
3.13 (Rename All)

Preparation

Recursive import with auto-detection
3.14 (Overwrite All)

Preparation

Recursive import with auto-detection
3.15 (Skip All)

Preparation

Recursive import with auto-detection
3.16 (test rename, overwrite and skip)

Preparation

Recursive import with specific trace
3.17 type 1 (Skip All)

Preparation

Recursive import with specific trace
3.18 type 2 (Skip All)

Preparation

Delete all traces in project - Right mouse click on
Traces folder and select ""Clear"

Redo 3.5, However only select metadata file instead
of directory trace

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning", select "Create Links to workspace”
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces”, unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select Overwrite All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory $ {local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to
workspace" and uncheck "preserve folder structure"
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces”, unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename”

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
workspace" and unselect "Preserve Folder Structure"
and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory $ {local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
workspace" and unselect "Preserve Folder Structure"
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

SWTBot

Imported trace appear in Traces Folder and the
Trace Type "LTTng Kernel" is set. Make sure
that trace can be opened SWTBot

All Traces are imported with respective trace

type set. Traces with name clashes are imported

with suffix (2). 1 trace (unrecognized.log) is

imported with trace type unknown. Make sure

that traces can be opened which have a trace type

set. The unknown trace type should open with

the text editor. SWTBot

All Traces are imported with respective trace

type set. Traces with name clashes are

overwritten . 1 trace (unrecognized.log) is

imported with trace type unknown. Make sure

that traces can be opened which have a trace type

set. The unknown trace type should open with

the text editor. SWTBot

All Traces are imported with respective trace

type set. Traces with name clashes are not

imported. 1 trace (unrecognized.log) is imported

with trace type unknown. The unknown trace

type should open with the text editor. SWTBot

All Traces are imported with respective trace

type set. Traces with name clashes are either

renamed, overwritten or skipped as per dialog

action. Make sure that traces can be opened

which have trace type set. The unknown trace

type should open with the text editor. SWTBot

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

4 CTF traces are imported with trace type
"Generic CTF Trace" . Make sure that these
traces can be opened SWTBot

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace
type "LTTng Kernel Trace". Make sure that this
trace can be opened. SWTBot

ProjectView
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3.19

3.20

321

3.22

3.23

3.24

3.25

3.26

327

3.28

3.29

Recursive import with specific trace
type 3 (Skip All)
Preparation

Recursive import with specific trace
type 4 (Skip All)
Preparation

Import wizard from workbench menu
with project selected

Import wizard from workbench menu
with no project selected
Preparation

Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
‘workspace" and unselect "Preserve Folder Structure"
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces”, unselect "Overwrite existing
without warning", select "Create Links to workspace”
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import... >
Tracing > Trace Import

3) Browse to directory $ {local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to
workspace" and

6) press Finish

1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import... >
Tracing > Trace Import

3) Browse to directory ${local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to
workspace" and

6) press Finish

Delete all traces in project

D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

1) D&D a trace with name of an existing trace into
traces folder
2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same
destination folder

Open Import wizard

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace” and select "Preserve Folder
Structure"

5) press Finish

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace
type "LTTng UST Trace". Make sure that these
traces can be opened.

All text files in directories are imported as trace
and trace type "Tmf Generic" is set. Note that
trace type validation only checks for file exists
and that file is not a directory. Make sure that
these traces can be opened. However traces with
wrong trace type won't show any events in the
table.

Verify that trace is imported to "Test" project
and can be opened.

Verify that trace is imported to default "Tracing"
project and can be opened.

Selected traces are added to the Traces folder
with proper icon. Trace can be opened.
Selected traces are added to the Traces folder
with default icon. Files can be opened with the
default editor.

Selected traces are added to the Traces folder
with default icon. For actual traces Trace type is
detected automatically. Trace can be opened,
For non traces the files are added with default
icon and they can be opened with the default
editor.

Verify that trace is added into the traces folder
with the trace name of the orignal trace plus a
suffix 2
Verify that trace is added into the traces folder
with the trace name of the orignal trace plus a
suffix 3

Verify that "Into Folder" text box cannot be
updated

All Traces are imported with respective trace
type set. The folder "clashes" is imported with its
traces inside. Make sure that traces can be
opened which have a trace type set.

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

ProjectView
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3.30

331

3.32

333

3.34

3.35

3.36

337

3.38

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)

Preparation

Delete with mixed selection of traces
and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no preserve
folder structure

Preparation

Import from zip archive specific traces
Preparation

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace” and select "Preserve Folder
Structure"

5) press Finish

6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory $ {local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace" and select "Preserve Folder
Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Create two trace folders under the "Traces" folder
2) Import 2 traces under each folder

3) Open all 4 traces

4) Select one trace in the first folder and the second
folder in the Project Explorer view

5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces" folder
2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer view
5) Right-click, Delete. Click Yes

1) Import 2 traces from different folders preserving
folder structure

2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite
existing without warning" and select "Preserve Folder
Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite
existing without warning" and unselect "Preserve
Folder Structure"

5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt" and
folder "kernel-overlap-testing"

4) Select trace type "Automatic", and select "Preserve
Folder Structure"

5) press Finish

Delete all traces in project

The wizard should finish quickly as no trace will
be imported. Make sure that traces can be opened
which have a trace type set.

All Traces are imported with respective trace
type set with suffix (2). The folder "clashes" is
imported with its traces inside. Make sure that
traces can be opened which have a trace type set.

A dialog should ask the user to confirm deletion
of the selected elements. Clicking OK should
remove all that was selected. The editor of the 3
deleted traces should be closed automatically
with one remaining editor opened.

A dialog should ask the user to confirm deletion
of the selected elements. Clicking OK should
remove all that was selected. The editor of both
traces should be closed automatically.

A dialog should ask the user to confirm clearing
of the folder. Clicking Yes should remove
everything under the selected folder and close
the traces

A dialog should ask the user to confirm clearing
of the folders. Clicking Yes should remove
everything under the selected folders and close
the traces

All the files get imported under their respective
folders. The CTF traces can be opened (kernel-
overlap-testing, simple_server...)

All traces are imported with trace type set. The
traces from folder "clashes" are renamed with
suffix (2). Make sure that the traces can be
opened

The specified traces are imported with trace type
set. Make sure that the traces can be opened.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

ProjectView
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3.39

3.40

341

4.1
4.2

4.3

4.4
4.5

4.7

4.8

4.9

5.1
52

6.1

6.2

6.4

6.5

6.6
6.7
6.8

6.9

6.10

6.11

Import from tar.gz archive, preserve

folder structure

Preparation

Import from tar.gz archive, no
preserve folder structure

Preparation

Import from tar.gz archive specific

traces

Trace
Trace menu
Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)
Open Trace (already open)
Experiments Folder

Experiments menu

Create experiment
Experiment
Experiment menu

Select Traces dialog
Select traces

Open experiment
Copy experiment

Rename experiment

Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)

Delete Experiment (open experiment)
Select Traces while Experiment is

open

Experiment Traces

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite
existing without warning" and select "Preserve Folder
Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite
existing without warning" and unselect "Preserve
Folder Structure"

5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt" and
folder "kernel-overlap-testing"

4) Select trace type "Automatic”, and select "Preserve
Folder Structure"

5) press Finish

Select an LTTng trace and open its context menu
Select the Open menu

Select the Copy menu and provide a new name.
Open.

Select the Rename menu and provide a new name.
Reopen.

Select the Delete menu and confirm deletion
Select trace and press Enter
Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context
menu

Select the New menu and provide experiment name

Select an experiment and open its context menu

Select the Select Traces menu
Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name.
Open.

Select the Rename menu and provide a new name.
Open.

Select the Delete menu and confirm deletion
Select an Experiment and press Enter

Select an Experiment and press Delete and confirm
deletion

Open an experiment, select expereiment and press
Delete and confirm deletion

Open an experiment and select an additional trace
(see 6.3)

All the files get imported under their respective
folders. The CTF traces can be opened (kernel-
overlap-testing, simple_server...)

All traces are imported with trace type set. The
traces from folder "clashes" are renamed with
suffix (2). Make sure that the traces can be
opened

The specified traces are imported with trace type
set. Make sure that the traces can be opened.

Correct menu opens (Open , Copy, Rename, ...)
Trace is opened and views are populated

Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Import XML
Analysis, Refresh)

Experiment appears under folder, no traces yet

Correct menu opens (Select, Open , Copy,
Rename, ...)

Select Traces dialog is open and populated w/
traces

Selected traces are imported in the experiment
Experiment is opened and views are populated
Experiment is replicated under the new name

Experiment is renamed
Experiment is deleted
Experiment is opened

Experiment is deleted
Experiment is closed and deleted

Experiment is closed and selected traces is
imported to the experiment

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

RCPTT
RCPTT

RCPTT

RCPTT
RCPTT

Manual

RCPTT

RCPTT
RCPTT
RCPTT

RCPTT

Manual

Manual

Numpad-enter doesn't work

Loic Import XML Analysis renamed "Manage XML Analysis"

Numpad-enter doesn't work

ProjectView

Automation
Candidate

Automation
Candidate See TestimportExportPackageWizard

Automation
Candidate
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7.1

72

7.3

74

7.5

7.6

7.7

7.8

7.9

7.10

7.11

8.1

8.2

83

8.4

8.5

9.1

9.2

9.3

9.4

10

10.1
10.2
103

11

11.1

Trace menu

Open trace
Remove trace

Drag and Drop from Traces

Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop from external (non-
traces)

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)
Drag and Drop of trace while

Experiment is open

Propagation

Preparation

Rename propagation
Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View Synchronization

Trace synchronization

Other trace nodes synchronization

Check trace properties

Check trace properties - experiment

Trace Type Selection

Preparation
Trace properties
Trace filtering

Supplementary Files

Preparation

Select an LTTng trace and open its context menu

Select the Open menu

Open Experiment, select the Remove menu and
confirm removal

D&D a few LTTng traces from the Traces directory

D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few traces from a non-Tracing project

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file
manager

1) D&D a trace with name of an existing trace into
experiment folder

2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same
destination folder

Open an experiment and D&D a trace from the
Traces directory (see 7.4)

Copy experiment

In Traces folder, rename a trace showing in both
experiments

In Traces folder, delete a trace showing in both
experiments

Add a trace to 2 experiments. Change its type from
Traces

Add a trace to 2 experiments. Change its type from
one of the experiments

Select a trace under a Traces folder in Project
Explorer view. Repeat with trace under an
Experiment.

Select a Traces folder, Experiments folder, or an
experiment in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check

the new properties view.

Open an experiment which contains LTTng kernel
traces, click on the experiment, check the new
properties view.

Import an file with unrecognized trace type ($ {local}
/traces/import/unrecognized.log)

Select the trace and open the Properties View

Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter for hidden
resources (Coolbar menu > Customize View... >
unselect . * resources)

2) Create Experiment with 2 LTTng CTF traces in it

Correct menu opens w/ Copy disabled + Remove

Trace is opened and views are populated
Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment with
proper icon. Experiment can be opened.
Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon (system icon).
Experiment cannot be opened.

Verify that trace is added into the traces folder
and experiment folder with the trace name of the
orignal trace plus a suffix 2

Verify that trace is added into the traces folder
and experiemnt folder with the trace name of the
orignal trace plus a suffix 3

Experiment is closed and selected traces is
imported to the experiment

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected
trace's "Resource properties" Property and
Value. The "Info > type" property shows the
selected trace category and trace type name.

The Properties view is updated with the selected
item's Property and Value. For Experiment verify
the "type" property is set.

The "Trace properties" should be populated

The "Trace properties" should be populated for
every subtrace

Imported trace appear in Traces with default
icon. File is can be opened by default Editor
(either Eclipse text or system editor depending
on plug-ins installed)

Selected trace type is blank

Untyped trace does not appear in list

Verify that .tracing directory is shown under the
project

RCPTT

Manual

RCPTT

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot
Manual
SWTBot

RCPTT

It also propagates when renaming trace in experiment

It also propagates when deleting trace in experiment

When experiment is selected, changing its type does not changes the type property in the properties view

until the experiment is selected again.

Only the properties for the experiment is populated

SWTBot tries invalid type for a given valid trace, same thing.

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

ProjectView
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11.2

11.3

114

11.5

11.6

11.7

11.8

11.9

11.10

11.11

11.12

11.13

12

12.1

122

12.3

12.4

12.5

12.6
13

13.1

132

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu

Delete Supplementary Files Action

Select and delete State History File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

Select and delete State History File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace

Delete Supplementary Files Action
while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Trace Package Export Wizard

Preparation

Open the trace package export wizard

Verify that org.eclipse.tracecompass.analysis.os.
Open a LTTng CTF trace and wait for indexing to linux.kernel.ht is created under .tracing/<trace
finish name>/.

a) Select trace under Folder Traces and click right

mouse button

b) Redo test: Select trace under Experiment Folder ~ Verify that menu item 'Delete Supplementary
¢) Redo test: Select Experiment Files..." is shown in the context-sensitve menu

1) Select trace and click right mouse button
2) Select 'Delete Supplementary Files..."

Verify that confirmation dialog box is opend and
<trace name>/StateHistory.ht is listed

Make sure that file .tracing/<trace

Select <trace name>/StateHistory.ht file and click on  name>/StateHistory.ht is deleted from the project
'Ok’ explorer view

Verify that two StateHistory.ht files are created
under .tracing/<tracel name>/ and .
/tracing/<trace2 name>/ respectively. Also
verify, that supplementatry folder for the

Open Experiment with 2 LTTng CTF traces experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and
shows 3 root entries:
1) Select Experiment and click right mouse button <exp name>, <tracel name> and <trace2 name>,
2) Select 'Delete Supplementary Files..." with their respective supplementary files below

Make sure that the selected file .tracing/<trace
Select one history file (<trace name>/StateHistory.ht) name>/StateHistory.ht is deleted from the project
and click on 'Ok’ explorer view

1)Redo 11.2 and 11.6 Make sure that both history files are deleted

2) Select both history files and click on 'Ok’ under .tracing/<tracel name>/ and .
tracing/<trace2 name>/ respectively

a) Redo 11.2 to create Supplementary File Verify that supplementary directory .

b) Delete trace tracing/<trace name>/ is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<tracel name>/ and ./tracing/<trace2
a) redo 11.6 to create experiment and Supplementary name>/ are NOT deleted. Also verify that the
File supplementary folder for the experiment .
b) delete Experiment /tracing/exp_name_exp is deleted.

a) redo 11.6 to create experiment and Supplementary ~ Verify that supplementary File StateHistory.ht .
File tracing/<tracel name>/ and ./tracing/<trace2
b) remove traces under Experiment name>/ are NOT deleted

Verify that trace is closed and supplementary
Open trace and then redo 11.4 files are deleted

1) In Project Explorer make sure that "Link with
Editor" button is selected
2) Open multiple traces and experiments

Verify that after each selection the corresponding
Select several traces and experiments one after each  trace or experiment element is selected in the
other in Editors area Project Explorer

Verify that after each selection the corresponding
Select several open traces and experiments one after  trace or experiment is brought to the top in the
each other in Project Explorer Editors area

1) In Project Explorer make sure that "Link with

Editor" button is not selected

2) Open multiple traces and experiments (if not open)

Select several traces and experiments one after each ~ Verify that selection in Project Explorer doesn't
other in Editors area change

Select several open traces and experiments one after

each other in Project Explorer Verify that Editor in focus is not changed

1) Import 2 traces that generate supplementay files

(trace2, kernel_vm)

2) Open both traces, wait for the indexing to finish

2) Add bookmarks in the two traces

Click on “File”, “Export...”, “Tracing”, “Trace

Package Export” and click Next

Alternatively, Right-click in Project Explorer on

Project and select "Export", “Tracing”, “Trace

Package Export” and click Next

Alternatively, select multiple traces, right-click and A wizard should appear with a list of projects

select "Trace Package Export" and traces to select. Next button should be
disabled.

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

Manual

RCPTT

RCPTT

RCPTT

SWTBot

small problem, might be GTK3

Automation
Candidate
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133

13.4

13.6

13.7

13.8

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16
14

14.1

142

143

144

14.5
14.6

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change format

Change export options, change format
and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

Preparation
Open the trace package import wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection

On the left side, select the project in which the traces
were imported. Then on the right side, selected both
traces.

With traces selected, press the Deselect All button.
Then press on the Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click
Deselect All. Then click Select All again.

1) Click on the Browse button.
2) Select a location on the filesystem
3) Enter the file name export.tar

Unselect the “Compress” checkbox.

Change to Zip format

Change to Tar format then select the Compress
checkbox.

Click Finish

Open the wizard again and select the traces (step
13.2, 13.3). Click Finish.

Open the wizard again and select the traces (step
13.2, 13.3). This time, choose Zip format. Click
Finish.

Open the tar.gz and the zip files in an archive
manager.

Open the wizard again and select the traces (step
13.2, 13.3). This time, unselect both Supplementary
files subtrees. Click Finish.

Create an empty tracing project. Make sure you have

export.tar.gz available from the Trace Package Export

Wizard (13) test case, which should include
everything including trace files, 1
and export-manifest.xml.

y files

Click on “File”, “Import...”, “Tracing”, “Trace
Package Import” and click Next

Click the Select button. Choose the previously created

project.

1) Click on the Browse button.
2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button.
Then press on the Select All button.

Unselect the trace2 element

Next should be become enabled when the first
trace is selected. If all traces are unselected, the
Next button is disabled.

Next should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to
a lower number.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to
0. The Next button is disabled.

When Select All is clicked, all the tree elements
are selected, the approximate size increases.
When Deselect All is clicked, all the tree
elements are deselected and the approximate size
decreases.

A file chooser dialog comes up. When the
destination file is entered, the “To archive file” is
filed with export.tar.gz. The Finish button should
be enabled.

The name of the archive file changes to export.
tar

The name of the archive file changes to export.
zip

The name of the archive file changes to export.
tar.gz

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The export.tar.gz file should be
created on the file system.

The Archive file name should be remembered
and already filled. A dialog should prompt the
user to overwrite. Answering No should keep the
wizard opened. Answering Yes should re-export
the archive and close the wizard.

The export.zip file should be created on the file
syslem

In both archives, verify that it contains:

1) A trace folder for each trace containing all
the trace files (excluding supplementary
files)

2) A .tracing folder containing all the
supplementary files

3) An export-manifest.xml file listing the
trace files, supplementary files and
bookmarks

Verify that the exported archive contains:

In both archives, verify that it contains:

1) A Traces folder containing all the trace files
(excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace
files and bookmarks

The first page of the wizard should appear
(Choose content to import)

The Into project field gets filled with the selected
project name.

Finish should be become enabled when the first
trace is selected. If all traces are unselected, the
Next button is disabled.

Finish should become disabled after Deselect
All, enabled after Select All.

All elements in the trace tree are unselected.

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

SWTBot

SWTBot

Manual

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

ProjectView

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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14.7

14.8

14.9

14.10

14.11

14.12

14.13

15

15.1

152

153

154

15.5

15.6

15.7

15.8

159

Trace sub-clement selection

Select/Deselect All

Finish the wizard

Supplementary Files

Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog - experiment
selection

Apply time offset dialog - Basic mode

Apply time offset dialog - cumulative

offset

Clear time offset

Apply time offset dialog - Advanced
mode

Apply time offset dialog - Advanced
mode - compute from selection

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click
Deselect All. Then click Select All again.

Click Finish
Right-click on trace2 in Project Explorer

Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the
archive file (step 13.4). Click Finish.

Open Project Explorer view and Properties view.

Create an empty tracing project. Import two different

traces to the project. Open the traces and note their
start time. Close the traces.

Select both trace elements in the Project Explorer
view. Right-click and select Apply Time Offset...

Select the Traces folder element in the Project
Explorer view. Right-click and select Apply Time
Offset...

Create an experiment with both traces. Select the
experiment element in the Project Explorer view.
Right-click and select Apply Time Offset...

Select a trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the
Offset in seconds column, enter a time with seconds
and decimals. Click OK. Open the trace.

Select the same trace element in the Project Explorer
view. Right-click and select Apply Time Offset... In
the Offset in seconds column, enter a time with
seconds and decimals. Click OK. Open the trace.

Select the trace element in the Project Explorer view.

Right-click and select Clear time offset. Click OK to
confirm. Open the trace.

Open one trace and close the other trace. Select both
trace elements in the Project Explorer view. Right-
click and select Apply Time Offset... Choose the
Advanced radio button.

Double-click the second trace to open it. Select an
event in its trace editor. Select the first trace editor.
Select an event in its trace editor. Click the button in
the dialog row of the second trace. Click OK. Open
both traces.

All elements in the trace tree are unselected.

‘When Select All is clicked, all the tree elements
are selected. When Deselect All is clicked, all
the tree elements are deselected..

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The two traces should appear under
the project in Project Explorer

Delete Supplementary files appears in the
content menu

Bookmarks appear in the list for the imported
traces

The corresponding trace opens at the
bookmarked event. Bookmarks are displayed in
the event table.

A dialog should prompt the user to overwrite for
each trace. Answering Yes to All should
overwrite without prompting again.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The timestamps in the trace are all offset by the
entered value. The Properties view shows the
'time offset' with the entered value.

The timestamps in the trace are all offset by the
cumulative sum of the previous and current
entered value. The Properties view shows the
'time offset' with the cumulative value.

The timestamps in the trace are back to their
original values. The Properties view shows the
'time offset' as blank.

The Apply time offset dialog opens and is
switched to Advanced mode. The Trace name
show both traces and the Offset in seconds is
blank. The Reference time for the opened trace is
set to its start time.

Both traces are open. Selecting an event updates
the Reference time for the selected trace, and
updates the Target time for all traces. Pressing
the button computes the Offset in seconds as the
difference between Target time and Reference
time for that row. The trace which has a
computed offset is closed when the OK button is
pressed. After reopening, the two previously
selected events now have the same timestamp.
The Properties view shows the 'time offset' with
the computed value.

Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Very fast

The trace opens but not at the bookmark event you need to double click again on a Bookmark to reveal it

When answering Yes to All for the overwrite warning for the first trace, another warning appears for the
overwrite of the second trace.

Automation
Candidate

Automation
Candidate

Automation

Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

ProjectView
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The trace is opened. The Reference time is set to
Select the first trace element in the Project Explorer  the trace start time. The Reference time and
view. Right-click and select Apply Time Offset... Target time can be copied, pasted, and edited.
Choose the Ad d radio button. Double-click the  Pressing the button computes the Offset based on
trace name to open it. Select the Reference time cell  the current time values. The trace is closed with
and copy the start time. Select the Target time and the OK button is pressed. After reopening, the

paste the value. Edit both values to different times. timestamps in the trace are offset according to
Apply time offset dialog - Advanced  Click the button in the trace row. Click OK. Open the the computed value. The Properties view shows
15.10 mode - compute from entered values  trace. the 'time offset' with the computed value. Manual No button in trace row, but when clicked, computes offset as normal

The opened traces are closed when the OK
button is pressed. After reopening, the
Open both traces. Select both trace elements in the timestamps in the traces are back to their original
Project Explorer view. Right-click and select Clear  values. The Properties view shows the 'time
15.11 Clear time offset with opened traces  time offset. Click OK to confirm. Open the traces. offset' as blank. Manual GTK 3 broke the apply time offset
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Section
TMF - BookmarksView

Target:

Step Test Case

1 Preparation

1.1 Preparation step 1

[ ]

Trace bookmarks
2.1 Show Bookmarks View

2.2 Open trace

2.3 Add Trace Bookmark

2.4 Open Trace Bookmark (1)

2.5 Open Trace Bookmark (2)

2.6 Open Trace Bookmark (3)

Delete Bookmark (from
2.7 table)

Delete Bookmark (from
2.8 table)

Delete Bookmark (from
2.9 Bookmarks view)

3 Experiment bookmarks

3.1 Create and open experiment

Action

Open and reset LTTng Kernel perspective

Select Bookmarks view (bottom folder)

Open an LTTng CTF Kernel trace

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the trace #1 and then double-click on bookmark in Bookmarks
view

Select bookmarks icon in event table right-click on icon and select
"Remove Bookmark"

Double-clicking bookmarks icon in event table.

Add a bookmark (see 2.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Create Experiment with 2 LTTng CTF Kernel traces in it and open
experiment

Verification

LTTng Kernel perspective opens with
correct Views.

Bookmaks view is shown

Views are populated. Verify that a
Kernel events editor is opened showing
LTTng Kernel specific columns

Make sure that bookmark icon is shown
on left site of the event row and is added
to the Bookmarks view with relevant
information (i.e. Description entered and
correct trace resource)

Make sure that event with bookmark is
selected and visible in event table

Make sure that correct trace #1 is
brought to top and correct event with
bookmark is selected in events table

Make sure that correct trace #1 is opened
and correct event with bookmark is
selected in events table

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

Verify that an Events editor is opened
showing LTTng Kernel specific columns

Type

To Do

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

BookmarksView
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32

33

3.4

35

3.6

3.7

Add Experiment Bookmark

Open Experiment Bookmark
M

Open Experiment Bookmark

@

Open Experiment Bookmark

3)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
c) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the experiment #1 and then double-click on bookmark in
Bookmarks view

Select bookmarks icon in Events view, right-click on icon and select
"Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Make sure that bookmark icon is shown
on left site of the event row and is added
to the Bookmarks view with relevant
information (i.e. Description entered and
correct experiment resource)

Make sure that event with bookmark is
selected and visible in event table

Make sure that correct experiment #1 is
brought to top and correct event with
bookmark is selected in events table

Make sure that correct experiment #1 is
opened and correct event with bookmark
is selected in events table

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

BookmarksView
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Target:

Section
TMF - Colors View

To Do

Comment

ColorsView

Test Case

Open a test trace

Open the colors view
Select a color and a filter
Add multiple colors
Change the color priorities

Delete all the colors

Action

a trace is visible in the events editor

the view is visible

Select a color and a filter, the matching events should update their
colors (background and foreground) to the new ones

Click on add 4 times, four colors should be displayed
By clicking on up and down, the order of the displayed colors should

change

The color filters should disappear.

Verification

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Comment
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Target:

Section
TMF - Filters View

[ 2 | o |

To Do

Comment

FiltersView

3.1

4.1

5.1

6.1

7.1

Test Case

Open a trace to be filtered

Open filter view

Create a filter on event type
and timestamp

Apply that filter

Create a filter on the
timestamp oring field values

Apply that filter

Create a filter with equals
node

Apply that filter

Create a filter with matches
node

Apply that filter
Create a filter with contains

node

Apply that filter

Action

Trace is opened

Filter view is opened

The filterview contains a filter on the event type and the timestamp
A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass

Verification

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
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Target:

Step

1

2.1

22

3.1

32

33

4.1

4.2

4.3

Section

TMEF - Sequence Diagram

Test Case

Preparation

Open perspective
Open TMF Sequence
Diagram View

Create and open experiment
with sequence diagram data

Manage View

Close view

Open view when
experiment/traces is already
loaded

Tooltip

Hover over interaction

Hover over interaction after
selection

Hover over time compression
bar

View Synchronization

Selection of interaction

Selection of event in events
table

Selection of new time range

View Actions

Action

1) Download traces.zip (if necessary) and unzip
into a local directory ${local}

2 )Use traces simple-server-thread1 and simple-
server-thread2 under traces/import/ for test cases
below

Open and reset LTTng Kernel perspective

Use menu Window — Show View — Other ... — Tracing
— Sequence Diagram

1) Create Tracing Project

2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread] and simple-server-
thread2

4) Add these 2 traces to experiment

6) Open (double-click on) the experiment

Close Sequence Diagram view

1) Close 'Sequence Diagram' View
2) load sequence diagram experiment
3) Open Sequence Diagram view

1) Goto to first page (no selection of any interaction or
lifeline) 2) Hover over first interaction (arrow or number)

1) Goto to first page
2) select first interaction
3) Hover over 3rd interaction

Hover over first element in time compression bar on the left
of the view

Select an interaction in the 'Sequence Diagram'
Select an sequence diagram event in the events table (type
SEND or RECEIVE)

Change time range in 'Histogram View'.

Verification

LTTng Kernel perspective opens with
correct views:

Project Explorer, Control, Control Flow,
Resources, Statistics, Histogram,
Properties, Bookmarks

Verify that 'Sequence Diagram' view is
shown

Verify that sequence diagram was loaded.
The interaction show the signal numbers
(Note that trace doesn't contain strings for
the interactions. A special parser would be
necessary to map signal number to trace)

Sequence Diagram View is removed from

Verify that sequence diagram was loaded.
Verify that all 17 pages are loaded.

Verify that tooltip appears with content
with interaction name and time stamp
(10000 14:58:00.740995147)

Verify that tooltip appears with content
with interaction names and time stamp
delta between selected interaction and
interaction that was hovered over (10001
— 10000 delta: 000.000 157 023)

Verify that tooltip appears with delta and
graph to show where delta is in relation to
current configured min max values. (delta:
000.000 3 480)

Verify that interaction is highlighted in
'Sequence Diagram' view. Verify that in
the events table the corresponding event is
selected. Verify that time stamps matches
Verify that corresponding interaction is
selected in the 'Sequence Diagram' view

Verify that the content of the 'Sequence
diagram' changes and the interactions are
part of the new window range

SWTBot

SWTBot

Manual

Manual

Manual

UlTest

UlTest

UlTest

UlTest

UlTest

UlTest

To Do

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

Note: UI tests are not SWTBot, but JUnit tests. Tests are
triggered programmatically right below the dialogs level

Difficult to get the numb of pages

Tooltip backgound is very dark and text is hard to read
on Ubuntu 14.10, 16.10 with default theme

https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523.

SequenceDiagram
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5.1

5.2

5.3

5.4

55

5.6

5.7

58

5.9

5.10

5.11

5.12

5.13

Test page navigation

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page' to
navigate through trace. Use also menu item 'Pages..." to jump

to specific page

1) Select menu item 'Pages...'
2) In text box type “9”
3) Click on 'OK'

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse
2) open find dialog

1) Select 'Sequence Diagram' view
2) press CTRL+f

Goto to page 1 —

1) Use menu item 'Hide Patterns..."

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.%03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns...'
3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate

zooming in
2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to

selection mode
2) select an interaction

1) Use button and menu item for zoom-out to activate

zooming out
2) click into sequence diagram view

Verify that different time ranges are
selected when changing page by looking
at Histogram View. Histogram View
window will show the start of the page.
Note that there are 10000 interactions per
page. In this traces there are in total
160032 interactions. Verify that last page
has 32 interactions between 2 lifelines.

Verify that a dialog box will show. Verify
that for this trace it shows 'Total: 17 pages
is shown” and the current page is
displayed in the text box. After step 3)
verify that page where changed to page 9.
For this trace page 9 is the page with 3
lifelines.

After 4) verify that interaction 10000
(player] — master) is selected. After 5)
verify that interaction 10100 (master —
playerl) is selected. After 6) verify that
10000 (player2 — master) is selected.
After 7) verify that interaction 10100
(master — player2). After 8 nothing else
will be found

After 4) verify that lifeline with name
player2 is selected (page 9 with 3
lifelines). After 5) player2 is selected on
page 10

Verify that previous used find criteria are
still in the list

Verify that find dialog opens

After 5) verify that Interactions with name
10003 and 10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are
shown

Verify that previous used hide criteria are
still in the list

Verify that 'Sequence Diagram' view
zooms in. Note that no selection is
possible.

Verify that selection is possible.
Verify that 'Sequence Diagram' view
zoom out. Note that no selection is
possible.

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SequenceDiagram
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5.14

5.15

5.16

5.17

5.18

5.19

5.20

5.21

522

5.23

5.24

5.25

Reset zoom

Configure min/max

Configure min/max (default)

Show node end

Show node start

Show node end short-cut

Show node start short-cut

Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug 391714)

1) Use button and menu item for 'Reset zoom factor' to reset  Verify that 'Sequence Diagram' view goes
the zoom level back to default zoom

After 1) verify that a dialog box shows
with default values. After 3) verify that
time compression bar changes some
colors. It will show more deeper red
because the max value is lower.

1) Select menu item 'Configure Min Max'
2) Change min to 100 and max to 2000 (keep scale and
precision)
3) press 'Ok’
After step 2) the default values are shown.
After step 3) the time compression bar
After changing min and max will change colors. Note that the default
1) select menu 'Configure Min Max'
2) press 'Default' 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation — Show node end

2 consecutive interactions.

Verify that end lifeline of the interaction
(the arrow) is shown

Goto to page 1 —

1) Resize view so that the beginning of the interactions are
not shown

2) select on interaction

3) Use menu item Navigation — Show node start

Goto to page 1 —
1) Resize view so that the arrow of the interaction is not

Verify that start lifeline of the interaction
is shown

shown
2) select on interaction Verify that end lifeline of the interaction
3) Press SHIFT+ALT+END (the arrow) is shown

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+HOME

Verify that start lifeline of the interaction
is shown
Verify that within a page the display

Press SHIFT+ALT+ARROW_DOWN scrolls down per view size

Verify that within a page the display

Press SHIFT+ALT+ARROW_UP scrolls up per view size

Verify that it's possible to navigate
through a page of the sequence diagram
view

Goto page 9 — Keep pressing + icon at the lowest right
corner of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to
print Verify that it is possible to print
1) Create Ifilter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

Verify that no exceptions occurred and
after 5) no filter are listed

values are computed based on all deltas of

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0

Key combination on Ubuntu 12.04 is used for something
else. This can be disabled using the combiz-settings-
manager (http://askubuntu.com/questions/171489/how-
to-unbind-shift-alt-up-shortkey-in-12-04)

After disabling this combination this test case passes

On Ubuntu 14.04, 14.10, this is not an issue, by default
the keys are not mapped.

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is a
visible empty space that is clickable in its place. Clicking
on it brings up the overview box which has a reasonable
size but movement is still hectic.

Bug 436442

The dialog is confusing on Ubuntu. The "from pages”
option do not update directly the values you enter

GTK 3 problem ?

Works on windows (including CTRL+P) Pass on 16.04 and 16.10

SequenceDiagram

... could it be cups giving you a hard time?
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5.27

Time Sync. without
interactions (Bug 391716)

1) Open trace without any sequence diagram information
2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

5) Change time current selected time in Histogram View

Make sure that no exceptions occurred

Manual

SequenceDiagram
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Section
TMF - EventsEditor
Target: Ubuntu 19.04 64 bit

Fail Type ToDo Comment

[ 1 [ o |

Test Case Verification Comment

1 Preparation

1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
2 Trace bookmarks Moved to sheet "BookmarksVIew"

3 Experiment bookmarks Moved to sheet "BookmarksVIew"

4 Filter

Only events matching regex are displayed. Top and
bottom filter status rows update while filtering is
ongoing. When filtering is done, status rows show
4.1 Filter In the header row, enter some regex and press Ctrl+Enter number of matching events. SWTBot Pass

Only some events matching regex are displayed.
In the header row, enter some regex and press Ctrl+Enter, then quickly Status rows show partial number of matching

42 Cancel filter press ESC before filtering is done events, with different 'stop' icon. Manual Pass | GTK 3 filter text doesn't work, but it workswell with GTK-3.16.6
All events are displayed. Selected event remains
4.3 Un-filter In the header bar, click the icon to delete a filter selected and visible. Status rows are removed. SWTBot Pass
4.4 Filter & Search In the filter bar, enter some regex; likewise in the search bar Events are filtered and highlighted accordingly SWTBot Pass
4.5 Search & Filter In the search bar, enter some regex; likewise in the filter bar Events are filtered and highlighted accordingly SWTBot Pass
5 Time Synchronization
Other views are synchronized to the selected event's Automation
5.1 Mouse synchronization Select any event in the table with the mouse button time Manual Pass Candidate
Select any event in the table using Up, Down, PageUp, PageDown, Other views are synchronized to the selected event's Automation
52 Key synchronization Home, End time Manual Pass Candidate
In the search bar, enter some regex, then search again with Enter/Shift- Other views are synchronized to the selected event's Automation
5.3 Search synchronization Enter time Manual Pass Candidate
The first event at or following the selected time is Automation
5.4 External synchronization In any other view that supports time synchronization, select a time. selected and visible. Manual Pass Candidate
Select an event with left button, press shift key and click select Range of events are highlighted. Selection range is Automation
5.5 Range selection another event updated in other views that support range selection Manual Pass Candidate
6 Event Synchronization

Verify that an editor is opened showing LTTng Kernel
specific columns. Views are updated with the new

6.1 Open trace Open an LTTng CTF Kernel trace trace. SWTBot Pass
The Properties view is updated with the selected
event's Property and Value. Timestamp and Content Automation
6.2 Mouse synchronization Select any event in the table with the mouse button are expandable. Manual Pass Candidate
The Properties view is updated with the selected
Select any event in the table using Up, Down, PageUp, PageDown, event's Property and Value. Timestamp and Content
6.3 Key synchronization Home, End are expandable. Manual Pass
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6.4

6.5

7.1

7.2

7.3

7.4

8.1

8.2

8.3

Search synchronization

External synchronization

Source Code / Model
Lookup

Preparation

Open call site

Open call site (no source
code)

Open model URI

Export to text

Export CTF trace

Export Other Trace

Copy to clipboard

Swap Columns and Change
Fonts

In the search bar, enter some regex, then search again with Enter/Shift-

Enter

In any other view that supports time synchronization, select a time.
The selected event in the editor is updated. Then give focus back to the

editor.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip to your

local disk.

3) Import demo C project to the Eclipse workspace of zip file

c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table
2) click right mouse button
3) select "Open Source Code" menu item

1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item

4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Copy to Clipboard" menu item
4) Paste it in a text file

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content

are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content

are expandable.

Verify that correct source code file and line number is

opened

Since the source code is not available the no source
code file is opened. Instead a error dialog is opened

(with title "FileNotFoundException")

Since the model is not available the model element is
not shown. Instead a error dialog is opened (with title

"FileNotFoundException")

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the

events table and that they are separated by tab
character.

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the

events table and that they are separated by tab
character.

Verify that the columns are printed as shown in the

events table and that they are separated by tab
character.

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

SWTBot

‘When the search wrap the table is losing focus, but not losing the focus at
the same time and the property view is not updated until you do an other
enter or shift-enter

no progress monitor dialog, only a job

EventsEditor
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9.1

8.2

8.3

Swap columns in events table

Change fonts

Reset fonts

1) Open a trace
2) Drag a column

1) Open the preferences
2) select new font for trace types

3) press apply
4) verify that the font changed

1) Open the preferences

2) Reset the font settings

3) Press apply

4) verify that the font changed

Covered by SWTBot tests

Covered by SWTBot tests

Covered by SWTBot tests

SWTBot

SWTBot

SWTBot

EventsEditor
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Target:

2.1

2.2

23

3.1

32

4.1

4.2

Section
TMF - Statistics View

Test Case
Preparation
Preparation

Open Perspective

Open TMF Statistics View

Open experiment
Manage View
Delete view

Open view

Open view when
experiment/trace is already
loaded

Other

Build of statistic index

Persistence of statistics
Range Synchronization

External synchronization
(full)

External synchronization
(range)

Action

Download traces simple-server-threadl and simple-server-thread1

from traces/import/

Open and reset LTTng Kernel perspective

Use menu Window — Show View — Other ... — Tracing —
Statistics

1) Create Tracing Project

2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-threadl and simple-server-thread2
4) Select trace type "Generic CTF Trace"

5) Add these 2 traces to experiment

Close the 'Statistics' View

Use menu Window — Show View — Tracing — Statistics

1) Close 'Statistics View' 2) load trace above trace 3) Open 'Statistics
view

Open trace

Open same trace multiple times after indexing of trace was finished
the first time

In any other view that supports range synchronization, select the full
range of the trace.

In any other view that supports range synchronization, select a new
range.

Verification

LTTng Kernel perspective opens
with correct views

Verify that 'Statistics' view is
shown

Verify that statistics are shown per
trace and per event type. Each
trace has 80021 events. Verify that
event types
ENTER/RETURN/SEND/RECEI
VE/INFO/after_fork_child are
counted.

Statistics' view is removed from
perspective

Statistics' view View is displayed
and re-populated

Verify that statistics are shown per
trace and per event type. Each
trace has 80021 events. Verify that
event types
ENTER/RETURN/SEND/RECEI
VE/INFO/after_fork_child are
counted

Verify that 'Statistics' view is
populated gradually during
indexation

Verify that when opening the trace
the x-times (x > 1), that the
statistics appear right away
without parsing the trace again

Events in 'Events in selection' is
updated and equals 'Events total'
values

Events in 'Events in selection' is
updated according to new range

To Do

Type

SWTBot

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

Path is actually Window -> Show view -> Tracing -> Statistics

Candidate for automation

Candidate for automation

StatisticsView

Automation
Candidate

Automation
Candidate
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5.1

52

5.3

5.4

55

5.7

5.8

.Multiple Trace

Synchronization

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces

(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)

Close all traces

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-overlap-

testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab

- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-click -> "Follow time
updates from other traces"

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab

Close all Events editor tabs

View shows the last opened trace

Events in 'Events in selection' is
updated according to new range
View is updated to show selected
trace. 'Events in selection' is
updated according to the selected
trace's previously selected range.

View shows the last opened trace
Events in selection' is updated
according to new range

View is updated to show selected
trace. 'Events in selection' is
updated according to the newly
selected time and range.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Candidate for automation

Candidate for automation

Candidate for automation

Candidate for automation

Candidate for automation

Candidate for automation

StatisticsView

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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Section
TMF - Time Chart View

Test Case

Verification

Type

To Do

Comment

Comment

TimeChartView

2.1

22

23

2.4

2.5

2.6

2.7

2.8

2.9

3.1

3.2

3.3

3.4

Preparation

Preparation step 1

Preparation step 2

Trace handling

Open trace

Open other trace

Open experiment

Select other trace
Select other trace (external)
Close view

Open view

Close trace/experiment

Close last trace

Time Synchronization

Mouse synchronization
(single time)

Mouse synchronization (time
range)

External synchronization
(single time)
External synchronization
(time range)

Open and reset LTTng Kernel perspective

Show Time Chart View

Open an LTTng CTF Kernel trace #1

Open an LTTng CTF Kernel trace #2

Open an experiment

Select trace #1 by clicking its trace entry in Time Chart view
Select trace #2 by clicking its editor tab
Close the Time Chart view

Show Time Chart view

Close trace #2 editor tab. Repeat with experiment editor tab.

Close trace #1 editor tab

Left-click on the time chart. The selected time line is updated.

Shift-left-click or left-drag on the time chart. The selected time range
is updated.

In event table, select an event.

In event table, select an event range with shift-left-click.

LTTng Kernel perspective opens with
correct views.

Time Chart view is shown

Trace #1 entry added to Time Chart
view. Trace #1 is selected entry. Range
of view is full trace range.

Trace #2 entry added to Time Chart
view. Trace #2 is selected entry. Range
of view is union of full trace ranges.

Experiment entry added to Time Chart
view. Experiment is selected entry.
Range of view is union of full trace
ranges.

Trace #1 is selected entry. View range
does not change. Trace #1 editor tab is
brought to top.

Trace #2 is selected entry. View range
does not change.

Time Chart view is removed from
tracing view

Time Chart view is displayed and re-
populated with opened traces data

Trace entry is removed from Time Chart
view. Range is view is union of
remaining full trace ranges.

View is cleared.

Other views are synchronized to the
selected time. Event at or following the
selected time is selected in the event
table.

Other views are synchronized to the
selected range. Event at or following the
selected time is selected in the event
table.

Selected time line is updated to the
event time. If necessary, range is
updated to show selected time.

Selected time line is updated to the time
range.

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

If T2 is outside of current range, view will be updated to include it (and not
necesseraly T1)

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate
Automation

Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate
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TimeChartView

4.1

4.2

4.3

44

4.5

Mouse wheel
synchronization

Mouse drag zoom
synchronization

Mouse drag move
synchronization

Mouse full range
synchronization

External synchronization

Zoom in/out with mouse wheel while holding Ctrl.
Drag zoom with right-button on time chart.

Drag move with ctrl-left or middle button on time chart.
Double-click with left button on time chart's time scale.

In any other view that supports range synchronization, select a new
Zoom range.

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the full
range

View range is updated to the new range

Manual

Manual

Manual

Manual

Manual

5.1
5.2

5.3
5.4

5.5
5.6

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark synchronization
Bookmark cleared

Enter a search regex in event table
Clear the search regex in event table

Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

Matching events are marked in time
chart

Marks are removed in time chart

Non-matching events are removed from
time chart

All events are shown in time chart

Bookmarked event is marked in time
chart

Mark is removed in time chart

Manual
Manual

Manual
Manual

Manual
Manual

Events that were hidden by last filter regex are not restored
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To Do

Comment

Section
TMF - Custom Parsers

Target:

Test Case Action Verification Comment

0 Prerequisites
Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
0.1 Get custom parser definition and logs  in /import

1 View management
Open and reset Tracing perspective, and open
1.1 Open perspective Time Chart view Time Chart view opens. SWTBot Pass
Create a tracing project, open Manage
Custom Parsers dialog and import text Custom parsers imported (TmfGeneric,
1.2 Import custom parser definitions and XML custom parser definitions Custom XML Log) RCPTT Pass
Traces imported in Traces folder of project
(ExampleCustomTxt.log,
Create a tracing project and import a text ExampleCustomXml.xml) and have their trace
1.3 Import custom traces and XML custom trace type auto-selected. RCPTT Pass
2 Custom parser management
Open Manage Custom Parsers dialog in
2.1 Open Manage Custom Parsers dialog Traces folder context menu Dialog opens. SWTBot Pass
Select "Text" radio button, click New...
button, enter Trace type, change stuff,

2.2 New (text) click Next, click Finish Custom parser appears in list. SWTBot Pass
Select custom parser, click Edit..., change Previously entered data appears, can be

2.3 Edit (text) stuff, click Next, click Finish edited. SWTBot Pass
Select custom parser, click Export, enter

2.4  Export (text) name, click Save Exported custom parser stored in file system. RCPTT Pass

2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
Click Import, find custom parser definition,

2.6  Import (text) click Open Imported custom parser appears in list. RCPTT Pass

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set ¢ to timestamp logged and d to
message logged, set timestamp format to
ss in both text boxes, click Next, click

2.7  New (XML) Finish Custom parser appears in list. Manual Pass Automation Candidate
Select custom parser, click Edit..., change Previously entered data appears, can be

2.8  Edit (XML) stuff, click Next, click Finish edited. Manual Pass Automation Candidate
Select custom parser, click Export, enter

2.9  Export (XML) name, click Save Exported custom parser stored in file system. Manual Pass Automation Candidate

2.10 Delete (XML) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
Click Import, find custom parser definition,

211 Import (XML) click Open Imported custom parser appears in list. Manual Pass Automation Candidate

3 Custom parser trace handling
Select test file in Traces folder, right-click,

select "Select Trace Type > Custom Text Trace type is assigned (re-open Select Trace Or select the trace and verify the trace type in the
3.1 Select trace type (text) > (parser name)" Type sub-menu to verify) RCPTT Pass properties view
Editor opens with events table, Time Chart
3.2  Open trace (text) Double-click on test file in Traces folder  view is populated. Manual Pass

Custom Parsers
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3.3

3.4

3.5

3.6
3.7

3.8

4.1

4.2

4.3

44

45

4.6

Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys

(457852)

Hide Raw viewer

Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace

2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in raw viewer and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table is
shown

Manual

Manual

RCPTT

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

should this be in events editor?

Custom Parsers
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Section ¥ ToDo _ Comment
TME - State System Explorer

Verificatio Comment Test that will make this swibot

1 Preparation
Open TMF State System Explorer  Use menu Window — Show View — Tracing

View - State System Explorer Verify thatState System Explorer view is shown SWTBat Pass s
2 Manage View

State System Explorer’view is removed from
perspective

21 Delete view Close the State System Explorer View SWTBat Pass s
Use memu Window — Show View — Tracing 'State System Explorer’view s displayed and re-
22 Openview — State System Explorer populted SWTBot Pass s
Verify that view i populated with kernel state system
(0.c.Lanalysis.os Jinux kemel) and statisics state
23 OpenTrace Open an LTTng Kemel Trace systems (o.e Lum satistics*) of opened trace SWTBot FERERIN <. s 10 shovld b emsmed for Trce Compass s
1) Close State System Explorer View
Open view when trace s already 2) Load LTTng trace Verify that view is populated with stte systems from
24 loaded 3) Open ‘State System Explorer’ view rac SWTBat |1 [T —————Y s
Th vlucs s onlysvalbl for e anges whee th rce
v, Only fter e "isied fhe s, thn he
s show up and pin "t of rage”. il
Works now: mathew
that view is populated with all kernl state B 1 i the searation i, s since | never s tis
system and staisies state systems of opencd view 1 ke Someone ls 0 st e, (Onlythe s i the
25 Open Experiment Open Experiment with 2 or more L TTng races _experiment (scparated by trace) RCPTT PR  sccond ac e cxpendable)
View is updated to show selected trace. State values,
Selectdifferen trace by clcking ts Evenis  starttime and end time are updated according to the
27 Selectother trace editor tab selected race's previously selected range. Manual Pass Automation Candidute
Verify that view is populated with stte systems from
26 Restrt Restart Eclipse. race Manual Pass
Close traces and experiment one by one from  Verify thatstate system explorer view s cleared after
27 Closealltraces the ditor tab closing the last trace: Manual Pass Avtomstion Candidte
3 Timestamp/ Time Range Selection
Selecttime in another view (. Histogram
31 Seleet timestamp View) that supports time synchronization Verify that selection time i updated in view Manual Pass [epp——
Selecta time range in another view that Mtifying "Selection End” oy i hisogram view shows the
32 Seleetiime rnge Supports time synchronization Verify that selection time range is updated in view Manual P cnd e or

4 Displaying of Changed Values

Selcct many different timestamps one afer the ~ Selection time bar is over the current time and sate
41 Highlighting of changed values  other Value of Atribute s shown Manual Pass Automstion Candidte
“Only Display Changes at Selected  Enable the “Only Display Changes at Selected
Timestamp” option with event  Timestamp” option with the oolbar button.  Verify thatonly the state values that hay
42 selection Select different Events from the Event T

d because Mot dossait exist anyonor bcause it now an
able.  of that event are displayed. NA  AbssciTimccnph view

Enable the “Only Display Changes at Selected.
Timestamp” option. Select *timestamps*
st Selected  corresponding to state changes (for example,
using the previous/next buttons in the Control  Verify that only the state values that changed a that
Flow View) timesiamp are displayed.

“Only Display Ch
Timestamp” with 1
selection

M docsrit xist anymore bcasse i o an
NA  AbstsciTimecnphview
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Target:

Section
TMEF - Flame Chart View

Test Case

Action

Verification

To Do

Flame Chart View

Comment

Comment

2.1

2.2

23

2.4

25

2.7

2.6

2.7

3.1

32

33

3.4
35

4.1

Download the test resources

Preparation
Open TMF Flame Chart View

Import generic trace

Import cyg-profile trace
Import cyg-profile-fast trace

Manage View
Delete view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment
Select other trace
Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)

Zoom to function (time graph)
Go to first event in trace

Synchronization

Time synchronization

Download this

Use menu Window — Show View — Other ... —
Tracing — Flame Chart

Import a trace that does not have any call stack
information, like a standard kernel trace

Import the trace in the "trace" directory of the
downloaded zip

Import a trace in the "trace-fast" directory of the
downloaded zip

Close the Flame Chart View

Use menu Window — Show View — Other ... —
Tracing — Flame Chart

Open "trace(-fast)" trace

1) Close 'Flame Chart' view

2) Open "glxgears-cyg-profile(-fast)" trace located
in the git in ctf test

3) Open 'Flame Chart' view

Open Experiment with 2 or more Flame Chart
traces.
(You can use both traces)

Select different trace by clicking its Events editor
tab

Restart Eclipse with Flame Chart trace opened

Close traces and experiment one by one from the
editor tab

Click on random time in the time graph pane

Click Previous/Next Event button

Double-click on a function in the table pane
Double-click on a function (interval) in the time
graph pane

Go to events editor, press home

Select a random time in another view

Verify that 'Flame Chart' view is shown

Verify that nothing is shown in the view, except
“Stack info not available (<tracename>)"

Verify that the Flame Chart View is populated with
some callstack information.
Verify that the Flame Chart View is populated with
some callstack information.

Flame Chart' view is removed from perspective

Flame Chart' view is displayed and re-populated

Verify that view is populated with call stack
information

Verify that view is populated with call stack
information

Verify that view is populated with all call stack
information (separated by trace).

View is updated to show selected trace.

Verify that view is populated with call stack from
trace

Verify that Flame Chart view is cleared after closing
the last trace

Selected time line is updated. Table is updated to show
the full stack information at the selected time. Selected
time is updated in other views.

Previous or next call stack change is selected and
corresponding active function and stack depth is
selected. Table is updated to show the full stack
information at the selected time. Selected time is
updated in other views.

Time range is updated to the full duration of the
selected function

Time range is updated to the full duration of the
selected function

the Flame Chart view is updated

Selected time line is updated. Table is updated to show
the full stack information at the selected time. If
selected time is outside current range, time range is
updated to include it.

SWTBot

Manual

SWTBot

SWTBot

Manual

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot
Manual

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass
N/A

Pass

Path is actually Window -> Show view -> Tracing -> Flame Chart

Automation Candidate

Automation Candidate

See comment 1.1. about the path

Automation Candidate
Automation Candidate
Automation Candidate

Automation Candidate

Automation Candidate

The vertical scroll bar is not updated(Sonia: only when you select
arendom time in the histogram view).If you select an event (in
another view)before the start of the calls, the vertical scroll bar
goes down.
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4.2 Event synchronization
4.3 Time range synchronization

5 iFunction name import - Text file

5.1  Invalid text file import

5.2 Valid text file import

6 iFunction name import - CDT

6.1  Binary import

6.2 Binary import Ittng 2.8+

Select a call stack-impacting event (function
entry/exit) in events table

Select a new time range in Histogram view.

Open 'trace' from Fibonacci.zip. Click the "Select a
mapping file" button in the view and click
"Browse" to select a random .txt file that does not
contain any debugging info.

Import a file "fibonacci.symbols"

Click the "Select a binary file" button in the view
and click "Browse" to select the fibonacci
executable (fibonacci).

Open an lttng 2.8+ trace with the executable
present

In addition to updating the selected time, the active
function at the event time is selected. Vertical scroll
bar is updated if necessary.

Time range is updated.

The function addresses do not change.

The view now displays function names instead of
function addresses (both in the timegraph and the call
stack areas).

The view now displays the function names for both
traces

The view now displays the function names for the
trace

SWTBot
SWTBot

Manual

SWTBot

Manual

Manual

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.

France : I am not sure what to do here Sonia : The bug is resolved
, you can specify a mapping file for each trace if you have a
multiple traces in one experiment.

Sonia :you have to specify the binary file for each trace.The view
won't display the function names for the both traces if we select
the fibonacci executable for a trace in an experiment with multiple
traces. Hung:Verified in Aug. 16-2018 at 14:47PM David: Same
issue as above

Flame Chart View
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Target:

Section
GDB Tracing

Test Case

Action

Verification

Type

To Do

[ 15 | o |

Comment

Comment

GDBTracing

1.1
12

2.1
22
23

3.1
32
33

4.1

42
43

5.1

52

6.1

6.4

7.1
7.2
73
7.4
7.5
7.6

8.1
8.2

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder

Traces Folder menu

Trace Import Wizard
Import traces

Trace Configuration
Project/executable selection
Select Trace Executable
Open configured trace
Source Code Lookup
Select event

Select another event

Events Table Navigation

Arrow keys

Scrolling
PgUp/PgDn

Home/End

Events Searching & Filtering
Search

Navigation

Un-search

Filter

Filter & Search

Un-filter

Events Synchronization

Synch from Events View
Synch from Trace Control

Open and reset the GDB Trace perspective

Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Close and open the new Tracing project

Select the Traces folder and open its context menu
Select Import Trace
Select a GDB Trace from samples directory and finish

Double-click on an un-configured trace

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"
3) Fill in the proper values in dialog and finish

Double-click on a configured trace

With mouse select an event in events table

redo 5.1

Update the current event using up/down keys within window

Update the current event using up/down keys outside window

Update the current event using PgUp/PgDn keys

Update the current event using Home/End keys

In the search bar, enter some RE

Navigate through highlighted events using Enter/Shift-Enter

In the search bar, clear the RE
In the search bar, enter some RE and press Ctrl+Enter

In the filter bar, enter some RE; likewise in the search bar

In the filter header, remove the filter

Click on an event in the Events View
Go up/down from the Trace Control View

GDB Trace perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer
Project contains the Traces folder

Correct menu opens (Open Trace, Import, New
Folder, ...)

Trace Import Wizard appears
Imported traces appear in Folders with proper icon

Verify that an Error Dialog opens that notfiies the
user to select the trace executable

Trace is configured (4.3 is successful, when 4.2 was
successful)

Trace is opened, events table and views are populated

The corresponding source code location is selected in
the source code file.

The corresponding source code location is selected in
the source code file.

Each keystroke modifies the selected event and the
corresponding source code location is selected in the
source code file.

Table is refreshed to display new current event and
the corresponding source code location is selected in
the source code file

Table is scrolled accordingly

Table jumps from first to last event and the
corresponding source code location is selected in the
source code file

Events corresponding to the RE are highlighted
Next/previous highlighted event selected accordingly
Events are displayed normally

Only events matching RE are displayed

Events are filtered and highlighted accordingly

Events are displayed normally

Trace Control View is updated; Debug View is
updated
Events View is updated accordingly

Manual
Manual

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot
Manual

Manual

Manual
Manual

Manual

Manual

SWTBot

SWTBot
SWTBot

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot
SWTBot
SWTBot

Manual
Manual

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass
Pass
Pass
Pass

Pass
Pass

Tested in base class

Tested in base class

Tested in base class

Tested in base class

Automation Candidate

Automation Candidate
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Target:

Section
LTTng 2.0 - CPU Analysis

Test Case

Action

Verification

Type

To Do

LTTng 2.0 - CPU analysis

11

1.2

1.5

2.1

2.2
23

24
25

2.6

3.1

Prerequisites

Import traces
Project View

Check analysis can
execute

Verify help message when
applicable

Check analysis for another
trace type

View Management

Populate analysis's view

Open view
Close trace

Open trace
Close view

Re-open view
View selection

Select an entry

Import LTTng Kernel traces in
Tracing project

In the project explorer and expand a
LTTng Kernel trace

In the project explorer, open and

expand the LTTng kernel trace, right-

click the CPU usage analysis and
select Help

In the project explorer, expand a non-

LTTng Kernel trace

Open an LTTng kernel trace and
expand the "CPU usage" analysis in
the project explorer

Double-click the CPU usage View
under the CPU usage analysis

Close the trace

With the view already opened, open
the trace

Close the CPU Usage view

Double-click the CPU Usage view
under the CPU usage analysis in
project explorer.

Select an entry in the tree viewer
section

"CPU usage" analysis is present
and it's not crossed out

A generic help message appears
with the name of the analysis

"CPU usage" analysis is not
present

"CPU Usage" View appears under
the analysis

The CPU usage Usage view opens
and triggers the cpu analysis. After
the analysis, both tree viewer and
xy charts are populated.

The CPU Usage view is emptied.

The CPU Usage view is populated.
The view is closed.

The view opens and is
automatically populated.

A new series is added to the xy
chart, corresponding to the
selected TID

SWTBot

Manual

SWTBot

Manual

SWTBot
Manual

SWTBot
SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass
Pass

Pass
Pass

Pass

Pass

84702

84702
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3.2

4.1

4.2

4.3

44

4.5

4.6

4.7

‘Select another entry

Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Mouse hover

Drag mouse selection

Select another entry from the tree

viewer

Drag move xy chart left and right with

middle button and shift mouse wheel

Zoom with ctrl mouse wheel up and
down, cursor inside xy chart

Scroll with mouse wheel up and
down, cursor outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right
button in xy chart

Hover mouse in xy chart region
anywhere

Drag select xy chart with left button

A new series is added to the xy
chart, and the previous TID's

'series is not displayed anymore

Time range is dragged. When
mouse button is released, series
are updated and new time range is
propagated to other views.

Time range is zoomed in and out,
relative to mouse cursor. When
mouse wheel is stopped for a short
time, series are updated and new
time range is propagated to other
views, including the tree viewer
beside the chart. The selected
process remains the same.

Table scroll up and down. Selected
process does not change. Vertical
scroll bar updated.

Tree viewer scrolls up and down.
Selected process does not change.

Selection highlighted. When
mouse button is released, time
range is zoomed to selection,
series are updated and new time
range is propagated to other views.
Selected process remains the
same.

Tool tip shows the total and
selected process (if any) cpu
usage at the time

Selection highlighted and selection
range is propagated to other views

SWTBot

Behavior is the one described in H22

SWTBot

SWTBot

Manual

Manual

SWTBot

Manual

SWTBot

Christophe: not
sure | understand.
Multiple series can
be selected; when
selecting a 2nd
series, the first one
is still displayed.
Simon: | think this
is old and refers to
an older view. With
the new tree view
the behavior is as

you described

Christophe:
selected process is
lost if the new time
range does not
contain data from
the process, even
when zooming
back out. Not sure
if it should be
marked as a fail.

LTTng 2.0 - CPU analysis
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4.8

4.9

4.10

4.11

Shift key selection

Sort columns

Drag mouse selection
(Status bar)

Shift key selection (Status
bar)

Click select with left button (begin

time), press shift key and click select
another time (end time)

Click on column headers once then
twice

Drag select xy chart with left button

Click select with left button (begin
time), press shift key and click select
another time (end time)

Selection highlighted and selection
rang is propagated to other views

Entries are sorted in ascending
then descending order on the
column value. Selected process
does not change.

Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference
between T2-T1 (can be negative)

Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference
between T2-T1 (can be negative)

Manual

Manual

Manual

Manual

5.1

6.1

6.2

6.3

Keyboard handling

Keyboard navigation in tree  With focus on table, use UP, DOWN,
viewer

Synchronization

Time synchronization

HOME, END keys

Select a random time in another view
Select a new time range in CPU

Time range synchronization usage view or in Histogram view.

Time range selection
synchronisation

In any other view that supports range
synchronization, select a new range.

Selected process is changed. xy
chart selection is updated. Vertical

'scroll bar updated.

Selected time line is updated. If
selected time is outside current
range, time range is updated to
include it.

Time range is updated.

Selection is highlighted. If the most
left time (T1) of selected time range is
outside the current range, then time
range is updated to include it

Manual

Manual

Manual

Manual

LTTng 2.0 - CPU analysis

Simon: Sometime
with GTKS3 sorting
by column cause
the process column
to add extra
padding between
the checkbox and
the label. On GTK2
everything seems
fine
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CPU usage works with works with 1 kernel
experiments Manual works only with 1 trace experiments trace experiments

43



5.3.0-TraceCompassTestCases

Section
TMF - Remote Fetching

Test Case

Action

Verification

TMF - Remote Fetching

Comment

Comment

2.1
2.2

3.1

32

33

3.4
3.5

3.6

3.7
3.8

4.1

4.2

4.3

44

5.1
52

Preparation
Step 1

Opening

Open Profile Editor 1
Open Profile Editor 2

Edit Profile - Add/Delete
Create Profile
Add Node
Add trace group

Add trace
Delete Trace

Delete Trace Group

Delete Connection Node

Remove Profile
Edit Profile - Reorder

Move profile up/down

Move connection node up/down

Move Trace Group up/down

Move Trace up/down

Edit Profile - Copy, Cut, Paste

Copy/Paste Profile
Copy/Paste Profile (Keys)

Open Trace Compass and reset Lttng perspective

Right-click on Traces Folder -> Fetch Remote Traces

... > Manage Profiles

Window -> Preferences-> Tracing -> Remote Profiles

Open Profile Editor > Click on 'Add' > Enter profile
name, remote information, root path and trace pattern

Select Profile node > right mouse click > select 'New

Connection Node'

Select node node > righ mouse click > select 'New

Trace Group'

Select trace group > right mouse click > select 'New

Trace'
Select trace > right mouse click > select Delete

Select Trace Group> right mouse click > select
Delete

Select Connection Node > right mouse click > select

Delete

Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and press

buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 connection nodes >

select 1 connection node > click buttons "Move
Up'/Move Down'

Make sure that there are 2 or 3 trace gropus > select 1
trace group > click buttons 'Move Up'/Move Down'

Make sure that there are 2 or 3 trace groups > select 1

traces > click buttons "Move Up'/'Move Down'

Select Profile > click right mouse button on a profile
> Select Copy -> click right mouse button on other

profile > Select Paste
Redo 5.1 with CTRL+C and CTRL+V keys

Lttng perspective opens with correct views

The Profile Editor of preference page opens
The Profile Editor of preference page opens

New Profile is created and template is provided

New Connection Node is create under the profile
and template is provided

New Trace Group is created under the node and
template is provided

New Trace is created under Trace Group and
template is provided

Trace is deleted
Trace Group is deleted

Connection Node is deleted
Profile is deleted

Profiles are moved up and down

Connection Nodes are moved up and down within
a profile

Trace Groups are moved up and down within a
connection node

Traces are moved up and down within a Trace
Group

Profile is pasted under the selected profile
Profile is pasted under the selected profile

SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

RCPTT

RCPTT
SWTBot

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT
RCPTT

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Bruno : Not this test, but the Fetch Remotes
Traces dialog, has a help button that does
nothing. Patrick: See Bug 440238.
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5.3

5.4

5.5
5.6

5.7
5.8
59

6.1
6.2

6.3

6.4

6.5

6.6
6.7
6.8
6.9

7.1

72

7.3

8.1

Copy/Paste Connection Node

Copy/Paste Connection Node
(Keys)

Copy/Paste Trace Group
Copy/Paste Trace Group (Keys)

Copy/Paste Trace
Copy/Paste Trace (Key)
Cut/Paste

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name
Error empty Connection node
name
Duplicate Connection node name

Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile
Export Profile
Import Profile
Import Profile

Remote Fetch Wizard

Preparation

Select Profile > click right mouse button on a

Connection Node > Select Copy -> click right mouse

button on other Connection Node > Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Trace
Group > Select Copy -> click right mouse button on

other Trace Group > Select Paste
Redo 5.5 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Trace >

Select Copy -> click right mouse button on other
Trace > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Redo 5.1 - 5.8 with cut and paste

Clear profile name
Add profile with name of existing profile

Clear Connection node name

Within a profile, add Connection node with name of

existing node
remove user name of a Connection Node

add invalid URI

Delete Trace Group root path

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button >
Select Folder and enter file name > OK

Click on Import Button > select profile XML file >

OK

Redo 7.2

1) Generate CTF trace in
<plugin>/generated/synthetic-trace

2) Import profiles from <plugin>/profiles/test-
profiles.xml

Profile is pasted under the selected Connection
Node

Profile is pasted under the selected Connection
Node

Profile is pasted under the selected Trace Group
Profile is pasted under the selected Trace Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace
Successful cut and paste

Error message "Profile must not be empty"
Error message "<name>: Duplicate profile name"

Error message "Node name must not be empty"

Error message "Duplicate node names"

Error message "URI must include user
information"

Error message "URI must include valid host and
port number" or "Unsupported URI scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be empty"
Error message "Invalid file pattern"

Only selected profiles are exported

Profiles are imported

after second import an error message appears
"Duplicate profile names"

RCPTT

RCPTT

RCPTT
RCPTT

SWTBot
RCPTT
RCPTT

RCPTT
RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
RCPTT
RCPTT
RCPTT

SWTBot

SWTBot

SWTBot

SWTBot

TMF - Remote Fetching

Trace (5.7) is done with SWTBot
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8.2

8.3

8.4

8.5

8.6

8.7

8.8

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory), only 1 trace
selected

Clear traces

Run Profile "TestAllRecursive"

Re-run Profile "TestAllRecursive"
(Rename)

Re-run Profile "TestAllRecursive"
(Overwrite)

Re-run Profile "TestAllRecursive"
(Skip)

Re-run Profile "TestAllRecursive"
(Overwrite 2)

Clear traces

1) Create Profile with Local connection, 1 trace group
(root /tmp/traces/) and 2 traces (.*syslog.* and .
*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on Next' button

4) Click on 'Finish'

Delete all traces from Traces directory

1) Create Profile with Local connection, 1 trace group
(root /tmp/traces/) and 2 traces (.*syslog.* and .
*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Rename' for the first trace and
'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Overwrite' for the first trace
and 'Overwrite ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Skip' for the first trace and
*Skip ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Select checkbox 'Overwrite traces without
warning'

3) Click on 'Next' button (enter password if needed)
4) Click on 'Finish'

Delete all traces from Traces directory

Verify that all test traces are imported with correct
trace types assigned. Verify that folder structure is
preserved.

All traces deleted

Verify that only the selected traces are imported
with correct trace types assigned. Verify that
folder structure is preserved.

All traces deleted

Verify that all test traces are imported with correct
trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.
log is importeds with unrecognized trace type.
Make sure that directory structure is preserved.

Verify that all test traces are imported with new
name and correct trace types assigned (LTTng
kernel, LTTng UST, custom text, custom XML).
The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Verify that all test traces are imported with correct
trace types assigned where old traces are
overwritten. (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make
sure that directory structure is preserved.

Verify that all test traces are skipped and no trace
is imported

Verify that all test traces are imported with correct
trace types assigned where old traces are
overwritten (no dialog box opens). (LTTng kernel,
LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized
trace type. Make sure that directory structure is
preserved.

All traces deleted

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

TMF - Remote Fetching

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot
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8.9

9.1

Re-run Profile "TestAllRecursive"
2)

Clear traces

Run Profile
"TestAlINonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces

Run Profile
"TestSpecificMutliGroupRecursiv
e

Clear traces

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

Connection Handling

Error cannot connect to remote
host (node doesn't exist)

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)

Delete all traces from Traces directory

1) Select profile "TestAlINonRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in
Fetch Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory
1) Select profile "TestSpecificMultiGroupRecursive"

in Fetch Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) Cancel import (red square or Cancel button)
Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Create profile with IP address that cannot be
connected to and run profile

Verify that all test traces are imported with correct
trace types assigned. The second page is omitted.
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that only traces from root path are imported
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs
are imported from root and subdirectory. Make
sure that directory structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs
are imported from root directory only. Make sure
that directory structure is preserved.

All traces deleted

Verify that only traces from root path are imported
(LTTng kernel, LTTng UST, custom text, custom
XML). Make sure that directory structure is
preserved.

All traces deleted

Verify that import operation is cancelled
All traces deleted

Verify that only traces from root path are imported
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved. 2 nodes directories are
created with the above traces stored

Operation to connect to remote node fails and error
dialog is shown with detailed information (after
time-out)

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

TMF - Remote Fetching

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot
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Error cannot connect to remote
9.2 host (wrong password)

10 ‘ Other Remote Backends
Clear traces

10.2 Remote Fetch using SSH

Create profile with valid IP address. When asked for
password enter invalid password

Delete all traces from Traces directory

Update profile with local username and run test 9.2
entering the correct password

Operation to connect to remote node fails with
time-out and error dialog is shown with detailed
information. Note time-out is as per remote
development preferences

All traces deleted

Verify that all test traces are imported with correct
trace types assigned (LTTng kernel, LTTng UST,

custom text, custom XML). The file unrecognized.

log is importeds with unrecognized trace type.
Make sure that directory structure is preserved.

Manual

Manual

TMF - Remote Fetching
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Section

Comment

LTTng 2.0 - ControlFlowView

Target:

LTTng 2.0 - Control Flow View

0.1

0.2

1.2
1.3

2.1

2.2

23

3.1

3.2

3.3

Test Case

Prerequisites
Import traces
Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph

Mouse handling

Drag move chart area

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer
Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

SWTBot

SWTBot

Manual
SWTBot

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
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3.4

3.5

3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

5.2

5.3

54

Mouse vertical scroll

Vertical scroll bar

Drag zoom time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

‘Shift key selection

Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph

(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Scroll with mouse wheel up and down

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

‘(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, stop time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

“negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.

Previous or next state is selected. Selected

time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Manual

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Removes focus on time graph

LTTng 2.0 - ControlFlowView
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55
5.6

5.7

5.8

5.9

5.10

5.1

5.12

5.13

5.14

6.1

6.2

6.3

6.4

Zoom In/Out
Filter Dialog

Filter Processes

Hide Arrows

Follow CPU Forward

Follow CPU Backward

Optimize

Re-Optimize

Go to next event of selected thread

Go to previous event of selected

thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

With focus on time graph, click Follow CPU
Backward button

Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to previous

‘event of selected thread

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.

verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event

Verify in the events table that the selected

‘thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

Manual
SWTBot

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - ControlFlowView
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1) Download traces.zip (if necessary) and unzip

into a local directory ${local}
2) Import Kernel trace ${local}

/traces/import/kernel-overlap-testing
3) Import UST ${local}/traces/import/trace

ust-overlap-testing

4) Create experiment with trace of 2) in it

LTTng 2.0 - ControlFlowView

Preparation
7.1 Open multiple traces (no overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and range (no Selected time line and time range is updated to
7.2 overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are restored to the
7.3 Select other trace (no overlap) tab selected trace's previously selected time and range. Manual
- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-
7.4 Open multiple traces (overlap) click -> "Follow time updates from other traces"  View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated to
7.5 (overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are set to the newly
7.6 Select other trace (overlap) tab selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. SWTBot
8.1  Filtering [
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persitent filter Switch between both open traces available Manual
9 ‘Miscellaneous
1) Open LTTng Kernel Trace
2) Select Control Flow View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated Manual
1) Open LTTng UST trace while CFV is open Verify that Control Flow View is empty, current
9.2 Select single time (Bug 477009) 2) Select event in events table window range stays change to ensure visibility Manual
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9.3

Window range synchronization
(Bug 477012)

1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
‘range 1'.

2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.

3) Go "left one page" on Resources view by
pressing left arrow in scroll bar.

4) Go "right one page" on Control Flow view.

Verify that after each step the initial window
range doesn't change

Manual

Test on Windows

LTTng 2.0 - ControlFlowView
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Target:

Section
LTTng 2.0 - Resources View

Test Case

Action

Verification

Comment

Comment

LTTng 2.0 - ResourcesView

0.1

0.2

1.2
1.3

22

2.3

3.1

3.2

3.3

3.4

35

3.6

Prerequisites
Import traces
Create experiment
View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

Drag move canvas

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective, and
select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down on
header or Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Click and drag vertical scroll bar

Drag select time graph with right button

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

SWTBot

SWTBot

Manual
SWTBot

SWTBot

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Manual

Manual

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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3.7 Double-click reset time range

3.8 Mouse hover (empty region)

3.9 Mouse hover (state)

3.10 Drag mouse selection

3.1 Shift key selection
4 Keyboard handling

Keyboard navigation in time graph

4.1 (process selection)

Keyboard navigation in time graph

4.2 (state selection)
5 Tool bar handling

5.1 Show Legend

5.2 Reset Time Scale

5.3 Select Previous/Next Event

5.4 Select Previous/Next Process

55 Zoom In/Out

5.6 Filter Dialog
6 Synchronization

6.1 Time synchronization

6.2 Time range synchronization

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Process button

Click Zoom In/Out button

Open Filter Dialog

Select a random time in another view

Select a new time range in Control Flow view
or in Histogram view.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows hover time, tid and process
name.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected

time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

Time range is updated.

Manual

Manual

Manual

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

SWTBot

SWTBot

Manual

Manual

LTTng 2.0 - ResourcesView

Time range is zoomed relative to selected time. If there is no selected
time, it is sometimes zoomed relative to left of window

If selected time T1 is outside range, time range is updated to
include it in center of window.

If selected time T1 is outside range, time range is updated to
include it in center of window. T2 is sometimes not included in
time window, even if it could be.

Automation
Candidate

Automation
Candidate

| TimeGraphViewTest

TimeGraphViewTest

TimeGraphViewTest

TimeGraphViewTest

Automation
Candidate

TimeGraphViewTest

Automation
Candidate

Automation
Candidate
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Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current Automation
6.3 synchronisation synchronization, select a new range. range, then time range is updated to include it Manual Candidate
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and unzip
into a local directory ${local}
2) Import kernel trace ${local}
/traces/import/kernel-overlap-testing
3) Import UST ${local}/traces/import/trace
ust-overlap-testing
4) Create experiment with trace of 2) in it
Preparation
7.1 Open multiple traces (no overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and range (no Selected time line and time range is updated to
72 overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are restored to the
7.3 Select other trace (no overlap) tab selected trace's previously selected time and range. Manual
- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-
74 Open multiple traces (overlap) click -> "Follow time updates from other traces"  View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated to
7.5 (overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are set to the newly
7.6 Select other trace (overlap) tab selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. SWTBot
81  Filtering |
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of Automation
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual Candidate
Make sure that previously set filter are still Automation
8.3 Persistent filter Switch between both open traces available Manual Candidate
9 'Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated Manual
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Target:

St

0

0.1

3.2

w

4

X

.5

36

37

Section
LTTng 2.0 - Control
View

Test Case Action

Prerequisites

For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.5.x or later) is required. Make sure that the
root session daemon is running (sudo lttng list -k) and have one
UST process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

a) Window — Preferences — General — Network Connections

Set Proxy b) Set “Active Provider” to “Direct”
General
Open perspective Open and reset LTTng Kernel Perspective

Manage View

Close view Close Control View
Use menu Window — Show View — Other ... — Lttng —
Open Control view Control

Connection Handling

1) Click Button 'New Connection..."
2) Select Tree item "Built-in SSH" and click on Create
3) Enter Connection Name (e.g. MyHost), enter Host Name (a
DNS name or IP address), username and password
4) Click 'Finish

Create Host Connection 5) In Tree select the newly create connection and click on 'Ok’

a) Select host to disconnect and click Button 'Disconnect’
Disconnect b) Redo test with context sensitive menu item 'Disconnect’

a) Select host to connect and click Button 'Connect’
Connect b) Redo test with context sensitive menu item 'Connect'

1) Restart Eclipse

2) Click Button 'New Connection..."

3) Select the host previously created

4) Select 'OK'. (Afterwards enter user ID and Password if
Select Host Connection necessary)

Node contexts sensitive 1) Connect to remote host
menu (host connected)  2) select connected node and click right mouse button

View button enable state 1) Connect to remote host (if necessary)
(host connected) 2) select connected node

Node contexts sensitive
menu (host 1) Disconnect from node
disconnected) 2) select disconnnected node and click right mouse button

LTTng Tracer Control User Guide: http:

LTTng Kernel perspective opens with
correct Control view on the left bottom
corner

Control view is removed from
perspective

Verify that Control view is shown

Make sure that after 4) the new
connection is shown in the tree. Verify
that the new host is shown in the
Control view (with 'Connection Name'.
After Ssh connection has been
established, make sure that Provider
and Session nodes are created in the
Control view underneath the host.
Verify that all active Providers (Kernel
and UST providers) are shown under
the 'Provider' node.

Verify that icon for the corresponding
node changes to the disconnect icon
and all sub-nodes are removed.
Verify that icon for the corresponding
node changes to the connected icon
and after successful SSH connection
all data is retrieved form the remote
host (Providers, sessions etc).

Make sure that SSH connection is
established and all data is retrieved
from the remote host ( (Providers,
sessions etc).

Verify that menu items are shown and
enabled/disabled depending on state:
'Connect’ (disabled)

Disconnect (enabled)

Refresh (enabled)

Delete (disabled)

Verify enable state of view buttons:
‘New Connection...' (enabled)
‘Connect’ (disabled)
‘Disconnect' (enabled)
‘Refresh’ (enabled)

'Delete’ (disabled)

‘Start' (disabled)

'Stop' (disabled)

‘Destroy Session...' (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that menu items are shown and
enabled/disabled depending on state:
'Connect' (enabled)

‘Disconnect' (disabled)

'Refresh’ (disabled)

‘Delete’ (enabled)

Type

Type

SWTBot

Manual

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

To Do

Comment

Comment

LTTng 2.0 - Control
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3.8

39

3.10

4.2

4.3

4.4

4.5

4.6

4.7

View button enable state
(host connected)

Delete

Create Host Connection
with ssh port

Session Handling
Preparation

Sessions Context
Sensitive Menu

Create Session (default
location)

Create Session (custom
location)

Create Session —
session already exists in
GUI

Create Session —
session already exists
on node

Session Context
Sensitive menu (session
inactive)

View button enable state
(session inactive)

Start Session

1) Disconnect to remote host (if necessary)
2) select disconnected node if necessary

a) Select node to delete (state disconnected) and click on

button 'Delete’

b) Redo test with context sensitive menu item 'Delete’

re-do 3.1 but this time specify a port number other than default

SSH port 22

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path' empty

4) Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MyOtherSession'

4) enter custom path (/tmp/myTraces) for 'Session Path*

5) Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path' empty

1) login to the remote host using a command shell
2) type Ittng create newSession and press enter. This will create
a session which is not know by the Control view.

3) Click right mouse button on 'Sessions'

4) Select ‘Create Session..." in the context sensitive menu
5) Enter session name 'newSession’, keep 'Session Path' empty

6) Select 'Ok’

Select newly created session and click right mouse button

Select newly created session (enable an event before)

a) Enable an event
b) Select session and click on button 'Start'

c) Redo test with context sensitive menu item 'Start'

Verify enable state of view buttons:
‘New Connection...' (enabled)
'Connect' (enabled)
‘Disconnect' (disabled)
'Refresh’ (disabled)

‘Delete’ (enabled)

‘Start' (disabled)

'Stop' (disabled)

'Destroy Session...' (disabled)
‘Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that host is removed from the
control view.

The connection should fail (unless
remote is configured for the specified
port)

Verify that menu items are shown and
enabled: ‘Refresh’, ‘Create Session...",
Load...' and 'Execute Command Script

Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):

'Session name' (=MySession)
'Session Path'
(=/home/<user>/traces/MySession_<d
ate and time>) and 'State"
(=INACTIVE)

Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):

'Session name' (=MyOtherSession)
'Session Path' (=/tmp/myTraces) and
'State’ (<INACTIVE)

Make sure that an error message
appears in the message area of the
dialog box with information that
session 'MySession' already exists in
the tree.

Verify that an error dialog box will
show with information that command
to create a session failed. session
already exists on the node. Select
'Details": Verify that the command
error detail is shown (with return value
(28))

Verify context sensitive menu items:
‘Refresh’ (enabled)

‘Start' (enabled)

'Stop' (disabled)

‘Destroy Session...' (enabled)
‘Import..." (enabled)

'Save...' (enabled)

'Enable Channel..." (enabled)
'Enable Event (default channel)..."
(enabled)

‘Record Snapshot' (disabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
'Connect’ (disabled)

‘Disconnect' (disabled)

'Refresh' (enabled)

'Delete’ (disabled)

‘Start' (enabled)

'Stop' (disabled)

'Destroy Session...' (enabled)
‘Import..." (enabled)

‘Record Snapshot' (disabled)
Verify that Session icon changes to
'ACTIVE' icon. Verify that property
view shows 'ACTIVE' for the session
state

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

30 seconds pause in the test to create manualy a
session on the host

LTTng 2.0 - Control
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4.10

4.1

4.12

5.1

52

53

5.4

5.5

5.6

57

5.8

6.1

Session Context
Sensitive menu (session
active)

View button enable state
(session active)

Destroy Session

Kernel Channel
Handling

Preparation

Enable Channel on
session level (default
values)

Enable Channel on
domain level (changed
values)

Enable Channel —
channel already exists

Domain Context
Sensitive menu

Channel Context
Sensitive menu

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on
session level (default
values)

Enable/Disable Channel

Kernel Event Handling

Select started session and click right mouse button

Select started session

1) In the Control view select session 'MyOtherSession'

2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu
4) Select 'Ok’ in the confirmation dialog box

1) Connect to remote host
2) Create new Session 'MyOtherSession'

1) Select session and right mouse click

2) Select menu item 'Enable Channel...!

3) Enter Channel name (e.g. myChannel) and keep default
values

4) Select Kernel

5) Click on 'Ok'

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel...

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel '"MyChannel' and click right mouse button

1) Select channel 'MyChannel' and click right mouse button
2) Select 'Disable' menu item

1) Select channel ‘MyChannel' and click right mouse button 2)
Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel...!
3) Enter Channel name 'MyChannel'

4) Select UST

5) Click on Button 'Default'

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

Verify context sensitive menu items:

'Refresh’ (enabled)

‘Start' (disabled)

'Stop' (enabled)

‘Destroy Session...' (disabled)

‘Import..." (disabled)

'Enable Channel..." (disabled)

'Enable Event (default channel)..."

(disabled) RCPTT

Verify enable state of view buttons:

‘New Connection..." (enabled)

'Connect’ (disabled)

‘Disconnect' (disabled)

‘Refresh’ (enabled)

‘Delete’ (disabled)

‘Start' (disabled)

'Stop' (enabled)

‘Destroy Session...' (disabled)

‘Import..." (disabled) RCPTT

Verify that session is removed from
the control view. SWTBot

Verify that domain 'Kernel' is created

under session and channel is added

under the domain. Verify that default

values for the channel are displayed in

the Properties view after selecting the

channel in the tree. RCPTT

Verify that channel is added under the

domain. Verify that correct values for

the channel are displayed in the

Properties view after selecting the

channel in the tree. RCPTT

Verify that error dialog box is opened
notifying that channel already exists. RCPTT

Verify context sensitive menu items:

'Refresh’ (enabled)

‘Enable Channel..." (enabled)

'Enable Event (default channel)...!

(enabled)

'Add Context..." (enabled) RCPTT
Verify context sensitive menu items:

‘Refresh’ (enabled)

'Enable Channel' (disabled)

‘Disable Channel' (enabled)

'Enable Event (default channel)..."

(enabled)

'Add Context..." (enabled) RCPTT
Verify that channel is disabled

(disabled channel icon shown, state

DISABLED shown in Properties view,

menu item 'Disable’ is disabled and

menu item 'Enable’ is enabled RCPTT
Verify that channel is enabled

(enabled channel icon shown, state

ENABLED shown in Properties view,

menu item 'Disable’ is enabled and

menu item 'Enable’ is disabled RCPTT

Verify that domain 'UST global' is

created under session and channel is

added under the domain. Verify that

default values for the channel are

displayed in the Properties view after

selecting the channel in the tree. SWTBot
See 5.7/5.8 RCPTT

LTTng 2.0 - Control
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71

72

7.5

7.6

7.7

7.8

8.1

8.2

83

1) Select session and click right mouse button
2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'
4) Select Radio button for 'Tracepoint Events'
Enable Event on session 5) Select top level tree node "All"
level (all tracepoints) 6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'

Enable Event on domain 4) Select Radio button for 'All Syscalls'

level (syscalls) 5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Probe'

4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,
Enable Event on see file /boot/System.map<kernel version>, valid symbols have

Verify that default channel (channel0)
is create under domain 'Kernel' and
that all tracepoint events are added
under the channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=TRACEPOINT,
State=ENABLED)

Verify that event with name syscalls is
added under the default channel
(channel0) with state ENABLED.
Verify properties view show correct
values when selecting a event in the
tree (Event Type=SYSCALL,
State=ENABLED)

Verify that event with name 'MyEvent'
is added under the respective channel
with state ENABLED. Verify properties
view show correct values when
selecting a event in the tree (Event
Type=Probe, State=ENABLED,

Channel level (Dynamic T ortas type, | used ' _stack' for
Probe) 5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button
2) Select menu item 'Enable Events..."
3) Select Radio button for 'Dynamic Function Entry/Return

Probe’
4) Enter Event Name 'MyOtherEvent' and Probe (e.g.
Enable Event on create_dev, see file or /boof

Channel level (Dynamic  version>)
Function Probe) 5) Click on Ok

1) Select multiple events (tracepoint events) under a channel
(not syscalls) and click right mouse button

Disable Event 2) Select 'Disable' menu item

Enable Event (tracepoint 1) Select multiple disabled events and click right mouse button
events) 2) Select 'Enable’ menu item

1) Select a probe event (function or dynamic probe) disabled
events and click right mouse button
2) Select 'Enable’ menu item
1) Create Session
2) Select session, right-mouse click and select 'Enable Events
(default channel)'
Enable Tracepoint Event 3) Enter a filter (e.g. sched) for the tracepoint tree and then
using filter in tree (Bug  select All

) 4) Click on Ok

Enable Event (probe
events)

UST Event Handling

1) Select session and click right mouse button
2) Select menu item 'Enable Events (default channel)...'
3) Select 'UST'
4) Select Radio button for 'Tracepoint Events'
Enable Event on session 5) Select top level tree node "All"
level (all tracepoints) 6) Click on Ok

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)...!
3) Select Radio button for 'Wildcard"

Enable Event on domain 4) Enter a wildcard (e.g. ust*)

level (wildcards) 5) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button
2) Select menu item 'Enable Events...'
3) Select Radio button for 'Log Level'
4) Enter Event Name 'MyEvent'
5) Select log level TRACE_ERR
Enable Event on 6) Select radio button for loglevel
Channel level (log level) 7) Click on Ok

0xc0101280, Event
Name=MyEvent)
Verify that event with name
‘MyOtherEvent' is added under the
respective channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=Function, State=ENABLED,
Symbol=create_dev, Offset=0x0,
Event Name=MyOtherEvent)
Verify that all selected events are
disabled (disabled event icon is
shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is
disabled and menu item 'Enable’ is
enabled

Verify that selected events are
enabled (enabled event icon is shown,
state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled
and menu item 'Enable’ is disabled

Verify that selected events are
enabled (enabled event icon is shown,
state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled
and menu item ‘Enable’ is disabled

Verify that only the selected
tracepoints (filtered) are enabled and
not all kernel tracepoionts

Verify that default channel (channel0)
is create under domain 'UST global'
and that a wildcard event **" is create
under the channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=TRACEPOINT,
State=ENABLED)

Verify that event with wildcarded name
(e.g ust*) is added under the default
channel (channel0) with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=TRACEPOINT,
State=ENABLED)

Verify that event with name 'MyEvent'
is added under the respective channel
with state ENABLED. Verify properties
view show correct values when
selecting a event in the tree (Event
Type=TRACEPOINT,
State=ENABLED, Log
Level=<=TRACE_ERR, Event
Name=MyEvent)

SWTBot

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties
view now

LTTng 2.0 - Control

Command to change state of events failed
Command failed! Command: Ittng --mi xml enable-event MyEvent -k -s auto-201 5527 -c sdf —probe
Error Output:

Error: Event MyEvent: Enable kernel event failed (channel sdf, session auto-20160607-005527)

Return Value: 43

<?xml version="1.0" encoding="UTF-8"2>

tance” xsi ocation="t

n i" xmins:xsi=" 0rg/2001/XMLSche

Command to change state of events failed
Command failed! Command: Ittng ~mi xml enable-event bob -k -s MyOtherSession ~function create_dev
Error Ouptut:

Error: Event bob: Non-default channel exists within session: channel name needs to be specified with -c name' (channel <default>, session MyOtherSession)

Return Value: 83
<?xml version="1.0" encoding="UTF-8"?>

htt

tp ype>FUNCTION</typ
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8.4

8.5

8.6

8.7

9.1

9.2

9.3

10

10.2

"

11.1

Enable Event on
Channel level (log level
oly)

Enable/Disable Event
(tracepoint events)
Enable/Disable Event
(tracepoint events)

Enable Tracepoint Event
using filter in tree (Bug
)

Enable Event by name
Contexts Handling

Add Context (to
channel)

Add Context (to
channel)

Add Context (to event)

Enable Events (from
Provider)

Enable Kernel Events

Enable UST Events

Importing to Project

Preparation

1) Select a channel (create if necessary) and click right mouse
button

2) Select menu item 'Enable Events...'

3) Select Radio button for 'Log Level'

4) Enter Event Name 'MyOtherEvent'

5) Select log level TRACE_INFO

6) Select radio button for loglevel-olny

7) Click on Ok

Redo tests 7.5 and 7.6 with UST tracepoint events

Redo tests 7.5 and 7.6 with UST (loglevel/loglevel-only) events

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter filter for the tracepoint tree and then select All

4) Click on Ok

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Select Tracepoints

4) Enter list of names (comma-separated) in text box

5) Click on Ok

1) Select kernel channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname,

pid)
4) Click on 'OK'

1) Select UST channel and click right mouse button

2) Select menu item 'Add Contexts..."

3) Expand tree and select contexts procname, pthread_id, vpid
and vtid

4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse button
2) Select menu item 'Add Contexts..."

3) Expand tree and select some contexts (e.g prio, procname,
pid)

4) Click on 'Ok’

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or
later this menu item has to be disabled

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —
Kernel

3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly created session

6) Select 'Ok’

1) Make sure that UST application is running on remote host
(see step 0)

2) Create a new session

3) Create a channel under domain 'UST global'

4) Select multiple UST Tracepoint events under Providers ->
<UST Process>

5) click right mouse button

6) select menu item 'Enable Event...'

7) Select newly created session

8) Select newly created channel

9) Select 'Ok’

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
7) Create new Tracing Project

Verify that event with name
'MyOtherEvent' is added under the
respective channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=TRACEPOINT,
State=ENABLED, Log Level=
==TRACE_INFO, Event
Name=MyOtherEvent).

See 7.5/7.6

See 7.5/7.6

Verify that only the selected trace
points (filtered) are enabled and not all
UST trace poionts

Verify that events entered in the comma-
separated list are added to the tree

Verify that command is successful (no
error).

NOTE: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

Verify that command is successful (no
error).

NOTE 1: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

NOTE2: For UST only contexts
procname, pthread_id, vpid and vtid
are supported

Verify that command is successful (no
error).

NOTE: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

Verify that domain 'Kernel' is created
under the new session. Verify that
default channel ‘channel0' is created
under the domain. Verify that selected
events are added under the channel
and are ENABLED.

Verify that selected events are added
under the selected channel and are
ENABLED.

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties
view now

DEPRECATED
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11.2

11.3

11.4

11.5

11.6

11.8
12

12.1

14

14.1

14.2

14.3

Import to project

Import to project
(Override)

Import to project
(Overwrite All)

Import to project
(Rename)

Import to project
(Rename All)

Import to project (Skip)
Import to project (Skip
All)

Refresh

Refresh

Event Filtering (LTTng
2.1)

Preparation

Enable UST Event on
session level

1) Select session from 11.1 and click right mouse button
2) Select 'Import..."
3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Overwrite' (kernel trace)

3) In dialog box select 'Overwrite' (UST trace, re-do if more
than 1 UST trace)

1) Repeat step 1 - 3 of test case 11.2
2) In dialog box select 'Overwrite All'

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Rename’ (kernel trace)

3) In dialog box select 'Rename' (UST trace, re-do if more than
1 UST trace)

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Rename All'

1) Repeat step 1 - 3 of test case 11.2

2) In dialog box select 'Skip' (kernel trace)

3) In dialog box select 'Skip' (UST trace, re-do if more than 1
UST trace)

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Skip All'

Press refresh button and context sensitive menu item for
different selections

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession"

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...!
3) Select 'UST'

4) Select Radio button for 'Tracepoint Events'

5) Select one tracepoint

6) Enter filter expression on a event field

7) Click on 'Ok'

After 2 verify that all traces are
selected by default and also that the
tracing project with name 'Remote' is
selected.

Verify that during import a progress
dialog is opened to show the progress
of the import operation.

Verify that traces are imported to the
project wiith name Remote and its.
Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel
Trace" is set and for the UST traces
the trace type "LTTng UST Trace" is
set.

Create Experiment, select all traces
and open Experiment. Make sure that
all view are populated correctly in the
LTTng Kernel Perspective.

Verify that traces are imported and
existing traces are overwritten

Confirmation dialog only shows once.
Verify that traces are imported and
existing traces are overwritten

Verify that traces are imported with a
different name

Confirmation dialog only shows once.
Verify that all traces are imported with
a different name

Verify that each skipped trace is not
imported

Confirmation dialog only shows once.
Verify that all traces are skipped

Verify that the Control View is
refreshed.

Verify that default channel (channel0)
is create under domain 'UST global'
and that the corresponding event is
created under the channel with state
ENABLED.

Verify that Properties view shows
correct values for this event (Event
Type=TRACEPOINT,
State=ENABLED, Filter=with filter,
Filter=the actual expression in LTTng
2.8+)

RCPTT

SWTBot

RCPTT

SWTBot

RCPTT

SWTBot

RCPTT

RCPTT

Experiment not tested with populated views

Tested with Remote Fetching 8.6

Hard to be sure that the overwrite worked

Tested with Remote Fetching 8.5

Tested with Remote Fetching 8.7

Hard to be sure that the skip worked

LTTng 2.0 - Control
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14.4

14.5

15

15.1

15.2

15.4

15.5

15.6

15.9

Enable UST Event from
provider

Create trace

Create Session With
Advanced Options
LTTng v2.1)

Create Session Dialog -
Advanced Button

Create Session Dialog -
Check box "Use same
protocol and address for
data and control"

Create Session Dialog -
Protocol list

Create Session Dialog -
Protocol list 2

Create Session Dialog -
Protocol propagation
Create Session Dialog -
Address propagation

Create Session Dialog -
Protocol propagation 2

Create trace with file
protocol

1) Execute 14.3

2) Select one UST Tracepoint event under Providers -> <UST
Process>

3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly create session and channel

6) Enter filter expression on a event field

7) Click on 'Ok’

1) Start Tracing

2) Stop Tracing after a view seconds
3) Import Trace to Project

4) Open Trace

5) Destroy Session

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Open Create Session Dialog box
2) Select "Advanced >>>"
3) Select "<<< Basic"

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox"Use same protocol and address for data
and control"

3) Check checkbox "Use same protocol and address for data
and control"

1) Open Create Session Dialog box and select "Advanced >>>"

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
and control”

1) Open Create Session Dialog box, select "Advanced >>>"
2) Select net6 for Control Protocol

3) Select file for Control Protocol

1) Open Create Session Dialog box, select "Advanced >>>"
2) Enter IP address in Control address

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
and control”

3) Select tcp for control protocol and tcp6 for data protocol

4) Check checkbox "Use same protocol and address for data
and control"

1) Open Create Session Dialog box and select "Advanced >>>"
2) Enter session name, select file protocol and enter directory
ItmpltestTraces/ in address field and press ok

3) Enable events, start tracing, wait for a few seconds, stop
tracing

4) Import traces to a existing tracing project

5) Destroy session

Verify that selected event is added
under the selected channel.

Verify that Properties view shows
correct values for this event (Event
Type=TRACEPOINT,
State=ENABLED, Filter=with filter,
Filter=the actual expression in LTTng
2.8+)

Make sure that only events are shown
in the events table that met the
condition in the filter expressions

After 2) verify that advanced options
are shown (e.g. Trace Path, Protocol,
Address and Port)

After 3) verify that advanced option are
not shown and only basic options are
there (Session Name and Session
Path)

After 2) verify that data Protocol and
data Address is enabled. Note that the
ports cannot be configured for net and
net6 when this button is unchecked. ->
port text fields are disabled

After 3) Verify that data Protocol and
data Address are disabled

Verify that the Control protocol
dropdown menu shows net, net6 and
file

After 2) verify that the data protocol
dropdown menu shows net, net6, tcp
and tcp6

After 2) verify that net6 is propagated
to the data protocol and and that the
data and control port text fields are
enabled

After 3) verify that file is propagated to
the data protocol and that the data and
control port text fields are disabled.
After 2) verify that the IP address is
propagated to the data address field

After 4) make sure that both data and
control protocol show net

Verify that the traces are stored on the
remote host under
ItmpltestTraces/kernel and
/tmpltestTraces/ust/<application(s)>
repectively.

After 2) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

Verify that the remote import dialog
box opens at step 4 (as described in
test cases 11.x) and it is possible to
transfer the traces to the tracing
project.

RCPTT

Manual

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

Need a human to fuly test
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15.10

15.11

15.12

15.13

15.14

16

16.2

16.3

Create trace with file
protocol and trace path

Create trace with net
protocol

Create trace with tcp
protocol and port

Live Streaming Session
(UST) - Initial
implementation

Live Streaming Session
(Kernel) - Inititial
Implementation

Preferences

Open Preference Dialog
Enable Logging

Disable Logging

1) Open Create Session Dialog box and select "Advanced >>>"
2) Enter session name, select file protocol and enter directory
/tmp/tmpTraces/ in address field, enter /newPath in "Trace
Path" text field and press ok

3) Enable events, start tracing, wait for a few seconds, stop
tracing

4) Import traces to a existing tracing project

5) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Open Create Session Dialog box and select "Advanced >>>"
3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok

4) Enable events, start tracing, wait for a few seconds, stop
tracing

5) Import traces to a existing tracing project

6) Destroy session

1) Uncheck checkbox "Use same protocol and address for data
and control"

2) Start relayd on Eclipse local machine with specified ports
(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp:/0.0.0.0:5678)

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select tcp protocol and enter IP address
of Eclipse local machine in address field, specify data and
control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok

5) Enable UST events (per UID channel), start tracing, wait for a
few seconds, stop tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok

5) Enable Kernel events, start tracing, wait for a few seconds,
stop tracing

6) Import traces to a existing tracing project

7) Destroy session

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Tracer Control Preferences)

In Tracer Control Prferences, check checkbox Logging

In Tracer Control Prferences, uncheck checkbox Logging

Verify that the traces are stored on the
remote host under
/tmpltestTraces/newPath/kernel and
[tmpltestTraces/newPath/ust/<applicati
on(s)> repectively.

After 3) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

Verify that the remote import dialog
box opens at step 4 (as described in
test cases 11.x) and it is possible to
transfer the traces to the tracing
project.
Verify that the traces are stored on the
Eclipse local machine under
/home/<user name>/lttng-
traces/<remote machine

ion name + nel
and /home/<user name>/Ittng-
traces/<remote machine
name>/<session name +

After 3) make sure that the Session

Path in the Property View shows the
URL with the configured parameters

After 5) Verify that dialog box for
selecting a tracing project is openend
that after selecting a project and
pressing next the default trace import
wizard opens. Then verify that it is
possible to transfer the traces to the
tracing project.

Verify that the traces are stored on the
Eclipse local machine under
/home/<user name>/Ittng-
traces/<remote machine

name>/ ion name + nel
and /home/<user name>/lttng-
traces/<remote machine
name>/<session name +

After 4) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

After 6) Verify that dialog box for
selecting a tracing project is openend
that after selecting a project and
pressing next the default trace import
wizard opens. Then verify that it is
possible to transfer the traces to the
tracing project.

Verify that session is created
successfully. Verify that after 6) the
trace appears in the Traces directory
of Remoter project. Verify that
relevants views are updated when new
data arrives

Verify that session is created
successfully. Verify that after 6) the
trace appears in the Traces directory
of Remoter project. Verify that
relevants views are updated when new
data arrives

Verify that tracer control preferences
exists and shows Tracing Group,
Logging, Log File (always disabled),
Append, Verbose Level (None, Level
1, Level2 Level 3)

Verbose Level radio buttons will be
enabled

Verbose Level radio buttons will be
disabled

RCPTT

Manual

Manual

SWTBot

SWTBot

RCPTT

RCPTT

RCPTT

Need a human to fully test

Implementation disabled for 2.0

Implementation disabled for 2.0
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16.4

16.5

16.6

16.7

16.8

16.10

16.11

17

171

17.2

Test Logging level none

Test Verbose Logging
(Level 1)

Test Verbose Logging
(Level 2)

Test Verbose Logging
(Level 3)

Append Mode

Change Tracing Group

Change execution
timeout

Reset

Create Channel with
advance features
(LTTng 2.2 features)

Configure Metadata
channel (kernel)

Configure Metadata
channel (UST)

Configure File rotation
(kernel)

Configure File rotation
(ust)

Buffer Type - toggle
UST/kernel

Execute 16.2 and execute some commands (e.g. create

session, enable event)

1) Execute 16.2
2) select verbose level Level 1

3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 2

3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 3

3) Execute some commands (e.g. create session, enable event)

Check checkbox Append, restart Eclipse and open Tracer

Control Preferences

Change Tracing group (e.g. tracing2) and execute a command

(while logging enabled)

Go to Remote Connection Preferences, Change Timeout

Reset to defaults

For the tests below a Ubuntu machine with LTTng 2.2 installed
(with Ittng tools 2.2.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under

tests/hello.cxx).

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...!

3) Select Checkbox 'Configure metadata channel

4) Update all text boxes
5) Click on 'Ok’

1) Re-do 17.2 with a UST channel

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...
3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

5) Fill in 2 in '"Maximum number of trace files'

6) Click on 'Ok’
7) Enable all kernel events
8) Start, wait and stop tracing.

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...!
3) Fill in channel name
4) Select UST

5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

6) Fill in 2 in '"Maximum number of trace filesfiles

7) Click on 'Ok’
8) Enable all UST events
9) Start, wait and stop tracing.

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...!
3) Select UST

4) Select Kernel

5) Slect cancel

Make sure that log file is created and
contains the executed commands and
command replies

Make sure that log file contains the
executed commands with -v option (e.
g. lttng -v create session) and the
command replies come with debug
information

Make sure that log file contains the
executed commands with -vv option
(e.g. lttng -vv create session) and the
command replies come with debug
information

Make sure that log file contains the
executed commands with -vvv option
(e.g. lttng -vvv create session) and the
command replies come with debug
information

Verify that tracer control preferences
are persisted and the log file is opened
in append mode (old file is not
overwritten)

Verify that Ittng command is executed
with command line option -g <group>.
Ignore any command reply errors (if
any)

After verify that values smaller than 5
and bigger than 600 are rejected
Verify: Group=tracing, Logging is
deselected, Append is deselected,
Verbose Level=None), and Command
Timout is 15

Verify after 3) that '‘Channel Name' is
set to metadata and the correspondig
textbox is disabled. Verify after 5) that
metadata channel was created under
the kernel domain. Also verify in the
properties view that all parameters are
set correctly when selecting the
channel metadata.

Verify after 3) that '‘Channel Name' is
set to metadata and the correspondig
textbox is disabled. Verify after 5) that
metadata channel was created under
the domain UST global. Also verify in
the properties view that all parameters
are set correctly when selecting the
channel metadata.

After 8) verify on the trace node that
trace files are not bigger than 1048576
bytes

After 9) verify on the trace node that
trace files are not bigger than 262144
bytes

Verify after 2 and 4 that the radio
buttons for the buffer type is disabled
and the buffer type "Global shared
buffers" is selected which is the value
for the kernel tracer.

Verify after 3) that the radio buttons
are enabled an no buffer type is
selected

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

This makes no difference for MI starting with Lttng 2.6

This makes no difference for M starting with Lttng 2.6

This makes no difference for M starting with Lttng 2.6

Command is successful. However tracer doesn't create
metadata channel. Bug in LTTng http:/bugs.Ittng.
orglissues/994

Need a human to check the size on the host

Need a human to check the size on the host
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17.7

17.8

18

18.1

18.3

18.4

18.5

18.6
18.7

18.8

18.9

18.10

18.11

18.12

Default UST Buffer Type

per PID UST Buffer
Type

per UID UST Buffer
Type

Snapshot Channel
(LTTng 2.3 features)

Preparation

Create Snapshot
Session

Enable Kernel Event

Start Session

Record snapshot

Create another snapshot
session

Enable UST Events
Start UST session

Record snapshot over
multiple sessions

Import traces

Stop and destroy
sessions

Network snapshot
session

Record snapshot when
session is inactive

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."
3) Select UST

4) Enter Channel Name

5) Select 'Ok’

Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...!
3) Select UST

4) Select 'Per PID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all ust events

9) Start, wait and stop tracing.

10) Import trace

Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...!
3) Select UST

4) Select 'Per UID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all ust events

9) Start, wait and stop tracing.

10) Import trace

Connect to a node with LTTng 2.3 installed

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path' empty

4) Select checkbox 'Snapshot Mode'
5) Select 'Ok’

Enable all Kernel Tracepoint and syscall events

a) Select session and click on button 'Start'

b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
‘Record Snapshot' and once with context-sensitive menu item

'Record Snapshot'

session name ustSession (as described in 18.1)

Enable all UST events
see 18.3

Select kernel and ust session (see 18.1 and 18.5) and click on

'Record snapshot' button

Open Import dialog (see 11.2)

Stop and destroy both sessions

1) Start relayd on Eclipse local machine (default settings: Ittng-

relayd)

2) Open Create Session Dialog box, select 'Snapshot Mode'and

select "Advanced >>>"

3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok
4) Enable events (UST and Kernel), start tracing, and record a

few snapshots, stop tracing

5) Import traces to a existing tracing project

6) Destroy session

Verify after 5) that the default buffer
type is configured for that channel (see
properties view). Note for LTTng Tools
2.2 the default is per-PID and for
LTTng Tools 2.3 and later it is per-UID

Verify after 6) that the per-pid buffer
type is configured for that channel (see
properties view). After 10) make sure
that for each UST application one
trace is created

Verify after 6) that the per-pid buffer
type is configured for that channel (see
properties view). After 10) make sure
that only one trace is created even
multiple UST applications are running.

Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):

'Session name'
‘Snaphshot ID*
‘Snapshot Name' (=snapshot-1)
'Session Path'
(=/home/<user>/traces/MySession_<d
ate and time>) and 'State'
(=INACTIVE)

lySession)

Make sure that the button and menu
item 'Record Snapshot' is enabled
Verify that channel and events a
successful enabled

Verify that Session icon changes to
'ACTIVE' icon. Verify that property
view shows 'ACTIVE' for the session
state

Make sure that the button and menu
item 'Record Snapshot' is enabled.
Also make sure that the Button and
menu item 'Import' is enabled.

Commands succeed without error
Make sure that snapshot session is
created successfully

Verify that channel and events a
successful enabled

see 18.3

Command succeeds without error
Verify that 4 snapshots are available
(3 kernel and 1 UST). Verify that all
snapshots are imported to the selected
tracing project

Verify that sessions are destroy
successfully

Make sure that all steps were
successfull. Also, import the traces
using the standard import instead of
the remote import

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
RCPTT

RCPTT

RCPTT

RCPTT

Manual

SWTBot

9) and 10) not tested with RCPTT

While doing this | found a few bugs but it ended up working. See
eclip: i and https:

Ibugs.eclip: b

/_bug.cgi?i
9) and 10) not tested with RCPTT

Note that the session has to be started at least once otherwise the
‘command will fail.
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19

19.1

20

20.1

202

20.5

20.7

20.8

20.9

20.10

20.11

20.12

21

211

212

213

Command Script

Execute command sript

Session Profiles

Save session

Save session (2)
Save session (no force)

destroy all sessions

Load Session (local)

destroy all sessions

Load Session (remote)

Open preference (1)

Open preference (2)

Export profile

Export profile (redo)

Import profile

Import profile (redo)

Delete profile

Kernel Event Filtering
(LTTng 2.6)

Preparation

Enable Kernel Event on
session level

Create a command script to create a session with kernel and
ust events enabled.

1) Create Tracing session

2) Select session and click right mouse button
3) Select Menu item "Save..."

4) Select 'OK"

1) Re-do 20.1 (use same session name)

1) Re-do 20.1
but deselect force button

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select a existing profile (from Local)

4) Select 'OK"

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select "Remote”

4) Select a existing profile (from Remote)

5) Select 'OK"

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Manage..."

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Remote Profiles

1) Open Preference page (see 20.7)

2) Select multiple profiles

3) Click on "Export..."

3) Select destination directory and click on "OK"

Redo 20.8

1) Open Preference page (see 20.7)

2) Click on "Import..."

3) Select a profile on media and click on "OK"
1) Redo 20.8

1) Open Preference page (see 20.7)
2) Select multiple profiles

3) Click on "Delete..."

3) Confirm deletion

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.6.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession'

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...!
3) Select 'Kernel'

4) Select Radio button for 'Tracepoint Events'

5) Select one tracepoint

6) Enter filter expression on a event field

7) Click on 'Ok’

Make sure that each command of
script is executed and script execution
is without errors

Make sure that the session is saved
under ~/.lttng/sessions on the remote
Make sure that session is availabe in
the workspace by opening Window-
>Preferences -> Tracing -> LTTng
Remote Profiles

Make sure that the session is saved
under ~/.Ittng/sessions.

Make sure that session is availabe the
user is prompted to skip or overwrite
the profile in the workspace

The save command will be rejected by
LTTng Tools

Make sure that the session is created

Make sure that the session is created

Make sure that the LTTng Remote
Profile preference page opens
Make sure that the LTTng Remote
Profile preference page opens

Make sure profile is exported to the
destination directory

Make sure that user is prompted about
to overwrite or skip existing profile

Make sure profile is imported and
available in workspace

Make sure that user is prompted about
to overwrite or skip existing profile

Make sure profile(s) are delete from
the workspace and disk

Verify that default channel (channel0)
is create under domain 'Kernel' and
that the corresponding event is
created under the channel with state
ENABLED.

Verify that Properties view shows
correct values for this event (Event
Type=TRACEPOINT,
State=ENABLED, Filter=with filter,
Filter=the actual expression in LTTng
2.8+)

SWTBot

Manual

RCPTT

SWTBot

RCPTT

RCPTT

RCPTT

Manual

Manual

Manual

Manual

RCPTT

SWTBot
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214

215

222

223

23

232

233

234

24

N

Enable Kernel Event
from provider

Create trace

LTTng UST Exclude
events (LTTng 2.5)

Preparation

Enable events with
exclude

LTTng UST per syscall
(LTTng 2.6)

Preparation

Enable selected syscalls

destroy session

Enable all syscalls

JUL, Log4J, Python
Logger

Configure JUL tracing
session (LTTng 2.6)
Configure Log4J tracing
session (LTTng 2.6)
Configure Python tracing
session (LTTng 2.7)

1) Execute 14.3

2) Select one Kernel Tracepoint event under Provider "Kernel"
3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly create session and channel
6) Enter filter expression on a event field

7) Click on 'Ok’

1) Start Tracing

2) Stop Tracing after a view seconds

3) Import Trace to Project

4) Open Trace

5) Destroy Session

For the tests below a Ubuntu machine with Ittng tools 2.5.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession'

1) Open Enable Event Dialog, select UST
2) Use wildcards
3) Enter a event name to exclude

For the tests below a Ubuntu machine with Ittng tools 2.6.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo Ittng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'MySession'

1) Open Enable Event Dialog, select Kernel

2) Select syscalls

3) In the tree, select selected syscalls

4) Select Ok

1) Open Enable Event Dialog, select Kernel
2) Select Syscalls

3) In the tree, select all syscalls

4) Select Ok

Configure JUL tracing session
using tree and event name
Configure Log4J tracing session
using tree and event name
Configure Python tracing session
using tree and event name

Verify that selected event is added
under the selected channel.

Verify that Properties view shows

correct values for this event (Event
Type=TRACEPOINT,

State=ENABLED, Filter=with filter,

Filter=the actual expression in LTTng

2.8+) SWTBot

Make sure that only events are shown
in the events table that met the
condition in the filter expressions Manual

Verify that event is added under the

UST Domain and relevant channel.

Verify that the Properties view shows

the exclusion: Exclusion=with

Exclusion, for Exclusion the actual

expression in LTTng 2.8+ SWTBot

Verify that the selectetd syscalls are
added added under the Kernel Domain
and relevant channel.

SWTBot
Verify that the selectetd syscalls are
added added under the Kernel Domain
and relevant channel.

SWTBot
verify that session is configured
correctly SWTBot
verify that session is configured
correctly SWTBot
verify that session is configured
correctly SWTBot
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Target:

Step
0

1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

Section
Tracing RCP

Test Case
Preparation

Start RCP

Start Tracing RCP

Start Tracing RCP with text trace

Start Tracing RCP with previously

opened text trace

Start Tracing RCP with Kernel
CTF trace

Start Tracing RCP with previously

opened Kernel CTF trace

Start Tracing RCP with new trace
with name conflict

Re-do 1.6

Start Tracing RCP with non-trace
file

Pass
33

Action

Open RCP from command
line or file explorer

Open RCP from command line
with --open <trace name with
absolute path>

Open RCP from command line
with --open <trace name with
absolute path>. Use same trace
than 1.2

Open RCP from command line
with --open <kernel trace name
with absolute path>

Open RCP from command line
with --open <kernel trace name
with absolute path>. Use same
trace than 1.4

Open RCP from command line
with --open <trace name with
absolute path>, where the
name of trace is the same than
1.2, but the trace is located at a
different location on disk

Open RCP from command line
with --open <kernel trace with
absolute path>, where name of
trace is the same than 1.4, but
the trace is located at a
different location on disk

Open file that is not a trace

Fail

Verification

Tracing RCP opens in default perspective

Trace will be opened with auto-detected
trace type

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Tracing RCP is opened, the trace is linked
to the Tracing project, the kernel analysis
trace type is selected and trace is opened.

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Verify that a new trace is linked to the
Tracing project and trace is opened. Verify
that the new trace name has a integer
number a suffix added.

Verify that a kernel trace is linked to the
Tracing project, the kernel analysis trace
type is selected and trace is opened. Verify
that the new trace name has a integer
number a suftix added.

Trace is imported (linked) however default ic

To Do

0

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

The delete key doesnt work on
Tracing project (we need to use the
mouse right click). Bug 486505.

The kernel trace opens in an editor
but the editor of the first trace gets
activated. Bug 443461.

Same bug happens with UST
traces

RCP

69



5.3.0-TraceCompassTestCases

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8
2.9

3.1

File menu

Open Trace (File)

Open Trace (File) with previously

opened text trace

Open Trace (Directory)

Open Trace (Directory) with
previously opened Kernel CTF
trace

Open Trace File with name
conflict

Re-do 2.5

Open file

Restart
Exit

vWindow Menu

Open Perspective

Use Menu "File -> Open Trace
..." In the file dialog select a
text trace and select open.

Use Menu "File -> Open
Trace...". In the file dialog
select a text trace and select
open. Use same trace than 2.1

Use "Menu File -> Open Trace
..." . In the file dialog select a
file of Kernel CTF trace
directory and select open.

Use "Menu File -> Open Trace
..." . In the file dialog select a
file of Kernel CTF trace
directory and select open. Use
same trace than 2.3

Use Menu "File -> Open Trace
..." In the file dialog select a
text trace and select open,
where the name of trace is the
same than 2.1, but the trace is
located at a different location
on disk

Use "Menu File -> Open Trace
..." . In the file dialog select a
file of Kernel CTF trace
directory and select open,
where the name of trace is the
same than 2.3, but the trace is
located at a different location
on disk

Open file that is not a trace

Use Menu File -> Restart
Use Menu File -> Exit

Use Menu Window -> Show
Perspective -> Tracing
Perspective

Trace will be opened with auto-detected

trace type

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Verity that the trace is linked to the Tracing
project, the kernel analysis trace type is

selected and trace is opened.

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Verify that the new trace is linked to the
Tracing project and the trace is opened.
Verify that the new trace name has a integer

number a suffix added.

Verify that the kernel trace is linked to the
Tracing project, the kernel analysis trace
type is selected and trace is opened. Verify
that the new trace name has a integer

number a suffix added.

Trace is imported (linked) however default ic

Verify that RCP is restarted with the
previously open perspective and trace

Tracing RCP exits

Tracing perspective is opened

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

RCP
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32

33

3.4

35

4.1

42

42

44

4.5

5.1

52

5.3

5.4

5.5

6.1

Open View

Preferences

Save Perspective As

Reset Perspective

'Help Menu

Help Contents

Help Contents (shortcut)

Install new Software

About

Version + Copyright

Content
TMF presence

LTTng presence
PCAP Network analysis presence
PcapNg Network analysis

presence

BTF presence

» Upgrade

Upgrade from previous release

Use Menu Window -> Show
View -> Select Tracing ->
Sequence Diagram

Use Menu Window ->
Preferences

Make changes of perspective
by moving views and use menu
Window -> Save Perspective
As. Enter a perspective name
and select Ok

Make changes of perspective
by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help
Contents

Use key F1

Use Menu -> Help -> Install
New Software... to install new
Eclipse feature

Use Menu -> Help -> About

Use Menu -> Help -> About ->

| Installation details

Open Tracing perspective
Open LTTng Kernel
perspective

Open Network Tracing
perspective

Open Network Tracing
perspective

Open BTF trace and
relevant view

Use Help -> Check For
Updates

Sequence diagram view is shown

Preferences dialog is shown

Perspective with new name is stored

After confirming the reset operation the
perspective is reset to the default layout.

Help content browser is opened. All
Tracing related help is included

Help content browser is opened. All
Tracing related help is included

Installation is successful

About dialog is opened all relevent
information (e.g. version, copyright years
etc) is up-to-date and correct.

Go over all tracing features and plug-ins
and verify that all have the correct version

‘and copyright years

Tracing perspective opens

LTTng Kernel perspective opens
Network analysis perspectiv opens
Network analysis perspectiv opens

View

RCP is upgraded

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Tested with RC2

RCP
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Target:

Step

Section
Trace Synchronization

Test Case

Pass

Action

Fail

Verification

ToDo  Comment

[ o [ o |

Comment

TraceSynchronization

0.1

0.2
0.3

21

22

23

Prerequisites
Import traces

Create experiment 1
Create experiment 2
View Management

Open Synchronization View
Delete view
Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment with
constant offset

Open trace

Re-open experiment

Restart

Functionnalities

Open experiment 2

Go back to previous
experiment

Synchronize experiment

Import the scp_dest and scp_src traces in

the synctraces.tar.gz file

Create an experiment containing those 2

traces

Create an experiment with any other trace

Use menu Window — Show View — Tracing —

Synchronization

Close the Synchronization View

Use menu Window — Show View — Tracing —

Synchronization

Open the experiment containing the 2
synchronizable traces

Right-click on the experiment and select

'Synchronize Traces'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second
Open an Lttng Kernel trace

Open the experiment containing the 2
synchronized traces

Restart Eclipse

Open the experiment containing traces that

do not synchronize

Re-open the experiment with the
synchronizable traces

Right-click on the experiment and select

'Synchronize traces'

Verify that 'Synchronization' view
is shown

Synchronization' view is removed
from perspective

Synchronization' view is displayed
and remains empty

Verify that the view is still empty

After a time, the view is populated
with synchronization result that
say 'accurate’. And one of the
original traces has been replace by
a trace with the same name, but
with an' ' at the end.

Verify that view is populated with
synchronization data from
currently opened experiment

Visually verify that a
synchronized trace is now
offsetted

Synchronization view is empty
View shows synchronization data
from the experiment

Verify that view is populated with
synchronization data from
experiment

Verify that the 'Synchronization'
view is empty

Verify that the 'Synchronization'
view contains the data from the
experiment

After the syncronization job
finishes, the synchronized
experiment is closed and
experiment 2 is selected. The
synchronization view is empty.

Manual Pass  cxperiment is closed after applying offset

Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Simon: not sure what should be the result of this operation
Bernd: | think it is to add a manual time offset on top of the synchronisation
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Section
LTTng 2.0 - Memory

Action

Verification

Type

To Do

Comment

Comment

LTTng 2.0 - Memory analysis

Analysis
Target:
Test Case
0 Prerequisites
0.1 Download traces
Import trace with memory
0.2 event

Import trace without

0.3 memory event
0.4 Import non-UST trace
1 Project View

Check analysis can
11 execute

Verify help message when
1.2 applicable

Check analysis cannot
1.3 execute

Verify help message when

14 not applicable
Check analysis for another

1.5 trace type

2 View Management
21 Populate analysis's view
2.2 Open view
2.3 Close trace
2.4 Open trace
2.5 Close view

Download UST trace with memory events
from https://secretaire.dorsal.polymtl.
ca/~gbastien/traces/eclipse_mem_ust.tar.
gz. Hung: | suggest downloading eclipse
trace

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack view

Import one LTTng Kernel trace

open the trace that contains the memory
events. In the project explorer, expand the
trace that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

open the trace that contains the memory
events. In the project explorer, expand the
UST trace that does not contain memory
events

In the project explorer, open and expand
the UST trace that does not contain memory
events, right-click the memory analysis and
select Help

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view

"Ust Memory" analysis is present and "normal”

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible
to execute and contains the requirement that is not
fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the
memory analysis. After the analysis, the XY chart is
populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

SWTBot

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

Manual

SWTBot
SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Automation
Candidate
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2.6 Re-open view
3 Mouse handling
3.1 Drag move time range
Zoom time range (mouse
3.2 wheel)
3.3 Drag select time range
34 Mouse hover
35 Drag mouse selection
3.6 Shift key selection
Drag mouse selection
3.7 (Status bar)
Shift key selection (Status
3.8 bar)
4 Synchronization
Preparation
41 Time synchronization
4.2 Time range synchronization
Time range selection
43 synchronisation

Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Drag select time graph with right button
Hover mouse in xy chart anywhere

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view
Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

The view opens and is automatically populated.

Time range is dragged. When mouse button is
released, the view refreshes with the new time range

Time range is zoomed in and out, relative to mouse
cursor. When mouse wheel is stopped for a short time,
series are updated and new time range is propagated
to other views.

Selection highlighted. When mouse button is released,
time range is zoomed to selection, series are updated
and new time range is propagated to other views.

Tool tip shows values for each thread at the given
timestamp

Selection highlighted. New selection is propagated to
other views

Selection highlighted. New selection is propagated to
other views

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selected time line is updated.
Time range is updated.

Selection range is highlighted.

LTTng 2.0 - Memory analysis

Automation
Manual Candidate
Automation
Manual Candidate
When you zoom in and a series was checked but it is
now filtered out, when you zoom out you lose you Automation
Manual checked series Candidate
Automation
Manual Candidate
Automation
Manual shows values for checked threads at given moment  Candidate
Automation
Manual Candidate
Automation
Manual Candidate
T1 cannot be less than T2, and delta cannot be Automation
Manual negative Candidate
T1 cannot be less than T2, and delta cannot be Automation
Manual negative Candidate
SWTBot
Automation
Manual Candidate
Automation
Manual Candidate
Automation
Manual Candidate
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Target:

Step

0.1

Section

Network Trace analysis

Test Case

Prerequisites
Import traces
Trace Import

Open the Network Tracing
perspective

Open trace
View management
Populate the views

Look up stream

Close the trace
Close view

Open view when trace is
already loaded

Open a non pcap trace
Stream List
Re-open trace

Create a filter from the
stream list

Apply filter

Pass

Action

Import the trace linked here

In the project Explorer, expand any LTTng kernel
trace

Double-click on the "TeamSpeak2.pcap" trace

Open the "TeamSpeak?2.pcap"
Open the Stream List view

Close the trace
Close the Stream List view

Re-open the trace. Open The Stream List view

Close the trace

Ensure only "TeamSpeak2.pcap" is opened

Right click on stream 0, and select "Extract as
Filter"

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
29.."

Fail

Verification

Verify that the events view, the properties and stream list
are displayed

The trace is given a "network" icon. When openned, the
events view and histogram view is opened

The views are updated

One stream is available with endpoint A being 00:0c:29:
7c:ab:f9

The stream list is emptied

The view is closed

The view opens with the correct title and is correctly
populated.

The stream list is emptied

The trace is opened

A filter named "FILTER stream eth 00:0c:29..." is
created

24/24 events pass the filter

Network Analysis

To Do Comment
3 0 1

Comment
SWTBot Pass
SWTBot Pass In SWTBot other trace is used
SWTBot Pass
Manual Pass | Automate
Manual Pass
Manual Pass
Manual Pass

Should change the action to "open a non pcap trace”
Manual Pass instead of "close the trace"
Manual Pass
Manual Pass
Manual Pass
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Target:

Section
XML analysis
Ubuntu 19.04 64 bit

Fail

Type

[ 10 | o |

To Do

Comment

0.1

0.2

0.3

2.1

2.2

2.3

2.4

2.5
2.6

2.7

2.8

29

3.1

3.1

Test Case

Prerequisites
Import traces

Get a test XML file

Make sure the XML file does
not exists in the project

XML file handling
Verify analysis not present

Import XML file

Edit XML file

Disable XML file

Enable XML file
View management

Populate the views
Open the 'Xml Control Flow

View'
Open another XML view

Close view

Open view when trace is
already loaded

Close traces
Open trace
Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

Action

Import LTTng kernel traces

Download the test XML file here: https://secretaire.
dorsal.polymtl.ca/~gbastien/Xml4Traces/Kernel.Linux.
xml

Open the Manage Xml Analyses menu and delete the

XML file if it exists (or The XML files are located in

<workspace directory>/.metadata/.plugins/org.eclipse.
tracecompass.tmf.analysis.xml.core/xml_files. Delete

the linux kernel XML file if it exists.)

In the project Explorer, expand any LTTng kernel trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the Kernel.
Linux.xml file and close the dialog.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.Linux
and click Edit

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the checkbox
next to Kernel.Linux to disable it and click Apply.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the checkbox
next to Kernel.Linux to enable it and click Apply.

Open an LTTng kernel trace (eg trace2 from the
tracecompass-test-traces repo)

Double-click the 'Xml Control Flow View' under the
analysis

Double-click the 'Xml Resources View' under the
analysis

Close both XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace
Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Verification

NOTE: XML haven't files haven't been update to st Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the 'Xml kernel State System' analysis is now present
under a LTTng kernel trace

Verify that the XML editor opens. The editor should have Design
and Source sub-tabs

Verify that the 'Xml kernel State System' analysis doesn't not
exist under a LTTng kernel trace

Verify that the 'Xml kernel State System' analysis is present
under a LTTng kernel trace

The 'Xml kernel State System' analysis should have a + next to it,
expand it and there should be 2 views under it: "Xml Control
Flow View' and "Xml Resources View'

A view titled 'Xml Control Flow View' should open and it should
look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it should
look quite similar to the Resources view's CPU entries. Both
XML views are opened.

The view are closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated
The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

Manual

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

Manual

SWTBot

Manual
SWTBot

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass
Pass

Pass

Pass

Pass

Comment

Needs an update we already ship XML by default with tracecompass.

SWTBot test uses different XML

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

XMLanalysis
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23

4.1

42

43

44

45

4.6

4.7

4.8

49

4.11

5.1

Select state in time graph
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shift key selection
Keyboard handling

Keyboard navigation in table
(entry selection)

Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with CTRL + mouse wheel up and down, cursor

inside time graph

Drag in time graph scale left and right with left button

Scroll with mouse wheel up and down, cursor outside
time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press shift
key and click select another time (end time)

‘With focus on table, use UP, DOWN, HOME, END
keys

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor. When
mouse wheel is stopped for a short time, states are updated and
new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to
other views.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time range
is zoomed to selection, states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end time,
duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.

Manual

SWTBot

Manual

SWTBot

Manual

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

XMLanalysis

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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52

5.4

5.4

6.1

6.2

6.3

6.4

6.5

6.6

6.7

7.1

72

7.3

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time

graph (process selection)
Keyboard navigation in time
graph (state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Filter Dialog

Filter Processes
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

‘With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use press ENTER while parent or child
process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next interval button

Click Zoom In/Out button

Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Select a random time in another view

Select a new time range in Resources view or in
Histogram view.

In any other view that supports range synchronization,
select a new range.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in
other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected interval (process/resource) is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time range.
States are updated and new time range is propagated to other
views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view
Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time range
is outside the current range, then time range is updated to include
it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

XMLanalysis
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Target:

Step

Section

Critical path

Test Case

Prerequisites

Import traces

Pass

Action

Import the 3
django traces from
the test traces

Create an
experiment with

Create experiment the 3 traces in it

Synchronize
experiment

View management

Open trace

Open experiment

Open view

Close view

Synchronize the
experiment, it
should be
accurate and 2 of
the traces will be
udpated

Open any of the
django traces in
Project Explorer

Open the django
experiment in
Project Explorer

Expand the Views
element, then the
Critical Path
analysis and click
on the Critical
Flow View

Close the Critical
Flow View

Fail To Do
6 0

Verification
Expand the Views element under the trace.
The OS Execution Graph analysis is there
and "normal". The Critical Path analysis is
there and the Critical Flow view is available
under it. Manual Pass
Expand the Views element under the trace.
The LTTng Kernel Execution Graph
analysis is there and "normal". The Critical
Path analysis is there and the Critical Flow
view is available under it. Manual Pass
Critical Path view is opened and empty SWTBot Pass
Critical Path view is closed Manual Pass

Comment
4

Comment

Automation
Candidate

Critical Path
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1.5

1.6

2.1

2.2

23

24

2.5

Unapplicable trace

Unapplicable

experiment

View population

Populate the view
with trace

Select worker in
time graph

Select state in
time graph

Select worker in
tree viewer

Populate the view
with empty path

Open a trace that
isnotaLTTng
kernel trace

Open an
experiment that
does not contain
LTTng kernel

traces

With the django-
client trace and
the critical path
view opened, in
the control flow
view, find the
process named

python (TID 9496).

Right-click on the

process and select

"Follow
python/9496"

Select an empty
region in the time
graph section

Select a state in
the time graph

Select a worker
from the tree
viewer section

Repeat steps of
2.1, with django-
client trace and
process lttng-
sessiond (TID
9355)

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
not there. The Critical Path analysis is there
and the Critical Flow view is available under
it.

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
there, but striked out. The Critical Path
analysis is there and the Critical Flow view

is available under it.

The LTTng kernel exec graph is executed
and at the end, the critical path view shows
the interaction between 3 workers.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State
is highlighted in time graph. Selected time
line is updated. Other views are
synchronized to selected time.

Same process is highlighted in time graph.

The Critical Path View is emptied

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Critical path analysis
or control flow view
is not here

Critical path analysis
or control flow view
is not here

Critical Path

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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255

26

2.7

2.8

3.1

3.2

3.3

3.4

Select again

Re-opening

Populate the view
with experiment

Populate with
trace with time

selection

Mouse handling

Drag move time
range

Zoom time range
(mouse wheel)

Zoom time range
(mouse drag)

Mouse vertical
scroll

Repeat steps of
2.1, and select
python/9496 again

Close the django-
client trace,
reopen it and
repeat steps of 2.1

Repeat steps of
2.1, but with the
django-experiment
instead

Re-open django-
client trace. In the
Control Flow View,
select a time after
the python
process exited,
then follow the
python/9496

process

Ctrl-Drag move
time graph left and
right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

Drag in time graph
scale left and right
with left button

Scroll with mouse
wheel up and
down, cursor
outside time graph

The critical path should be the same as 2.1

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed
and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Path View should be populated

like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

Table and time graph scroll up and down
and remain aligned. Selected worker does
not change. Vertical scroll bar updated.

Manual

Manual

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Critical Path

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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3.5

3.6

3.7

3.8

3.9

3.10

3.11

4.1

4.2

Vertical scroll bar

Drag select time
range

Double-click reset
time range

Mouse hover
(empty region)

Mouse hover
(state)

Drag mouse
selection

‘Shift key selection

Keyboard handling

Keyboard
navigation in table
(process selection)

Keyboard
navigation in table
(tree expansion)

Click and drag
vertical scroll bar

Drag select time
graph with right
button
Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another

‘time (end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,

in Windows use LEFT,

RIGHT keys while trace
or worker is selected

in Linux use SHIFT
LEFT, RIGHT keys while
trace or worker is
selected

Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name and PID.

Tool tip shows worker name, state name, priority, date,
start time, end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time

difference between T2-T1 (can be negative)

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For trace, tree is expanded or collapsed. Time graph item
expansion is updated. Vertical scroll bar updated. For
workers, it does nothing.

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Automation
Candidate

Automation
Candidate

[processName, pid]
(e.g. [postgres, Automation
32554)) Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Critical Path

Does the same effect
as with focus on time
graph (see 4.4)
However, "Enter"
works. Update the
action description?
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4.3

4.4

5.1

52

5.3

54

5.5

5.6

5.7

5.8

5.9

Keyboard
navigation in time
graph (process
selection)

Keyboard
navigation in time
graph (state

selection)

Tool bar handling

Align views

Show Legend

Reset Time Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,

'RIGHT keys

Click on the Align View
Button, with another time
graph view, eg the
Control Flow view
opened above or under

Click Show
Legend button

Click Reset Time
Scale button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom In/Out
button

Select a time, and click
on the Add Bookmark
button

Add more bookmarks,
then click on the
next/previous marker
buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark button

Selected worker is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

When it is pressed, moving the line between tree viewer
and time graph will move the line of the other view. If not
pressed, the line can be moved without affecting the other
views

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.

The bookmark is added and is displayed in the other views
as well (if enabled)

The time graph view navigate between the bookmarks,
States are updated and time selection is propagated to
other views. When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Align option is now

in down arrow at the
extreme right of the

view

When there is no
selection, sometimes
it zooms relative to
left of window

Critical Path

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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5.11

5.12

6.1

6.2

6.3

Do not show markers

Show markers

Synchronization

Time
synchronization

Window range
synchronization

Selection range
synchronization

Click on the down arrow

at the extreme right of
the view, then expand
Show markers and

uncheck the Bookmarks

box

Same as above, recheck
the Bookmarks box

Select a random
time in another
view

Select a new window
range in another view
In any other view
that supports
selection range
synchronization,
select a new
range.

With a critical path

displayed, select a
time in another view

that is not in the range

of the process being

displayed in the critical
6.4 Out of region selection path view

All remaining bookmarks disappear from the view, but
remain in other views where the they are enabled

'The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Selected time is updated and the critical path view is
synced with the other

Manual

Manual

Manual

Manual

Manual

Manual

Automation
Candidate

Automation
Candidate

Critical Path

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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Target:

Section
LAMI

Ubuntu 19.04 64

Test Case

Verification

Comment

Comment

0.1

0.2

1.1
1.2

2.1

22

2.3

24

2.5

Prerequisites
Import traces
Download analysis
stubs

Custom external
analysis

Add all stubs
analysis

Actions availables

Actions avaliables

Delete analysis

Run analysis
Reports

Reports node

Same name report
Delete node
Open a report

Open the same
report again

any trace since we use stub for the result

https://bugs.eclipse.org/bugs/attachment.cgi?id=263946
from bug: https://bugs.eclipse.org/bugs/show_bug.cgi?
id=493941

Create the following analysis ($name, $command):

analysisEmpty, analysisEmpty

analysisMultipleRow, analysisMultipleRow
analysisMultipleSimilarRow, analysisMultipleSimilarRow
analysisOneRow, analysisOneRow

multipleReports, multipleReports

invalidAnalysis, invalidAnalysis

errorResult, errorResult

clone, analysisOneRow

Right click on "External Analyses" node

Click the "add" action

Insert $name

Insert "fullpath/$executable” which is the full path to the stub
executable.

ex:"/tmp/stub/stubAnalysis" where stubAnalysis is the stub
executable

The path do NOT support ~ or relative path

Right click on a non-strikethrough custom analysis.

Right click on a strikethrough custom analysis.

Right click on the tuple (clone, invalidAnalysis)
Select the delete action for the node

Launch remaining analysis via righ-click and run action

Expand the "Reports" node under the Project Explorer

Execute the "analysisOneRow" analysis again.

Right click on the duplicate "analysis OneRow" node and click

on the delete action
Right click on any report and select the "open" action

Right click again on the same report to open it

All new external analysis are present under the "External
Analysis" node in the Project explorer view.

All new elements do NOT have the strikethrough text
style applied

EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)

Manual

The run action can be clicked and in enabled text mode. Manual

The run action CANNOT be clicked and is in disabled text Manual

The analysis does not appear in the list anymore. Manual

analysisEmpty should return a message to the user regarding the emptiness
errorResult should return an error message to the user and display the result ¢
All other one have result and should result in a new table and new report nodg

The "Reports" node under the Project Explorer should contain
4 report:

analysisMultipleRow Report

analysisMultipleSimilarRow Report

analysisOneRow Report

multipleReports Manual
An additional node should be present under the "Reports"

node:

analysisOneRow Report #2

Note: This behaviour is subject to change in the following

year but still an action will be taken on same name report

creation. Manual
The node reports is not present anymore Manual
A new panel should open with the result table of the

analysis Manual
A new panel should open with the result table of the

analysis Manual

Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass
Pass

Pass

Analysis still appears in the list of the external analyses of the trace. When opening

another trace, however, its external analyses do not have the deleted analysis
anymore.

launching an analysis on a closed trace doesn't do anything

"multipleReports" is displayed "multipleReports Report" in
Report

Lami
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2.6 Multiple report
Result Table
3.1 Prerequisites
32 Hide table
3.3 Show table
34 Sorting
3.5 Colum Resizing
3.6 Multiple selection
3.7 | Unselect selection
Bar Chart
4.1 Create
4.2 Series dialog add
Series dialog
4.3 remove
4.4 Creat chart
4.5 Selection
4.6 Multi selection
4.7 Deselection
4.8 Y axis
Keep the chart
4.9 open
Hide the table
4.10 results
5 Scatter Chart
5.1 Create
5.2 Creat chart
53 Selection
54 Multi selection
5.5 Deselection
5.6 Mouse hovering
5.7 Full deselection

Open the "multipleReports" report.

Open the "analysisMultipleRowReport"
Click the "Toggle" button in the right corner of the result table

Click the "Toggle" button in the right corner of the result table

Sort all column by clicking on the column name. Clicking
multiple time on the name should change the ordering sorter.

Resize the column

Select multiple rows by holding ctrl and clicking on multiple
unselected rows of the table

Deselect multiple rows by holding ctrl and clicking on multiple

selected rows of the table

Use the menu on the upper right of the result table and select
"create bar chart"
Select any x and any y click add

Remove all newly created series via the delete button

Select any x and y and click add and "ok"
Click on any bar inside the chart
Ctrl+click on other unselected bar
Citrl+click on other selected bar

Recreate the same graph but with the y log scale option
enabled

Keep the chart open

Hide the table results

Use the menu on the upper right of the result table and select
"create scatter chart"

Select any x and y and click add and "ok"

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Hover mouse in the graph

Click in the chart when no hovering cross is present

Validate that a user is able to navigate between sub tab
of a report

The result table is hidden

The result table is shown

Validate that the order make sense

Validate that the resize works

Multiple selections are highlighted in the table

_The clicked row should not be selected anymore

Note: a bar chart does NOT perform agregation of
categories values

Series are added to the series list

User should be able to delete series

A bar chart should be created
Note: a bar chart does NOT perform agregation of
categories values

The corresponding row should be selected in the table
and the chart should highlight the selected bar

Selections should be highlighted in the result table and
the chart

The clicked bar should be removed from selection and
the result table update with the current selections

Y axis should be in log scale mode
Note: check for zero value and negative handling since
log scale do not support zero and negative

A scatter chart should be created

Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart

On mouse hovering a cross should snap to the nearest
point

All selected objects should be deselected

Manual

Manual
Manual
Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual
Manual

Lami

Waker and Wakee process name sorting is confusing: "Xorg" is sorted
lower than "compiz", which is sorted lower than "rcu_sched".

| selected Wakee Process TID as X axis, but TID is not displayed well
because of the sheer number of TIDs

When there are too much bars inside the chart it is more difficult to click on
a bar

When checking logarithmic scale Y, all y that do not support logarithmic
scale Y are not removed. When a Y is selected, all y that do not support
logarithmic scale Y are removed
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Target:

0.1

1.1

1.2

1.5

Section

LTTng 2.0 - /O
Analysis

Test Case

Prerequisites

Import traces
Project View

Check analysis
can execute

Verify help
message when
applicable

Check analysis
for another
trace type
View
Management

Import LTTng
Kernel traces in
Tracing project

In the project
explorer,
expand a LTTng
Kernel trace

In the project
explorer, open
and expand the
LTTng kernel
trace, right-click
the Input/Output
analysis and
select Help

In the project
explorer,
expand a non-
LTTng Kernel
trace

Verification

"Input/Output”
analysis is
present and
"normal” (not

striked-out) SWTBot

A generic help
message
appears with
the name of the

analysis Manual

"Input/Output"
analysis is not

present SWTBot

Pass

Pass

Pass

Comment

LTTng 2.0 - I/O analysis
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Open an LTTng
kernel trace and

expand the "Disk I/O
"Input/Output”  Activity" View
Populate analysis in the  appears under
21 analysis's view project explorer the analysis SWTBot
The Disk 1/0
Activity view
opens and
triggers the
Double-click the input/output
Disk 1/0 Activity analysis. After
View under the the analysis, the
Input/Output Xy charts is
2.2 Open view analysis populated. SWTBot
The Disk 1/0
Activity view is
2.3 Close trace Close the trace emptied. Manual
With the view  The Disk I/O
already opened, Activity view is
24 Open trace open the trace  populated. Manual
Close the Disk  The view is
25 Close view I/O Activity view closed. Manual
Double-click the
Disk 1/0O Activity
view under the The view opens
Input/Output and is
analysis in automatically
2.6 Re-open view  project explorer. populated. Manual
3 View selection
4 Mouse handling

LTTng 2.0 - I/O analysis

Graph is emptied
Disks are unchecked

when opening the
trace

Disks are unchecked
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4.1

4.2

4.3

Drag move time
range

Zoom time
range (mouse
wheel)

Drag zoom time
range

Drag move xy
chart left and
right with middle
button

Zoom with
mouse wheel up
and down,
cursor inside xy
chart

Drag select time
graph with right
button in xy
chart

Time range is
dragged. When
mouse button is
released, series
are updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out, relative to
MOUSe CUrsor.
When mouse
wheel is
stopped for a
short time,
series are
updated and
new time range
is propagated to
other views.
Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.

Manual

SWTBot

Manual

LTTng 2.0 - I/O analysis

89



5.3.0-TraceCompassTestCases

4.4

4.5

4.6

Mouse hover

Drag mouse
selection

Shift key
selection

Hover mouse in
xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Tool tip shows
the puntual disk
activity, with
units in <unit>/s

Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection range
is propagated to
other views

Manual

Manual

Manual

LTTng 2.0 - I/O analysis
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4.70

Drag mouse
selection
(Status bar)

Drag select xy
chart with left
button

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)

Manual

LTTng 2.0 - I/O analysis
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6.1

Shift key
selection
(Status bar)

Time

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Select a random
time in another

synchronization view

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to
include it.

Manual

Manual

LTTng 2.0 - I/O analysis
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6.2

6.3

6.4

Time range
synchronization

Time range
selection
synchronisation

Disk I/0O Activity
works with
experiments

Select a new
time range in
Disk I/O Activity
view or in
Histogram view.

In any other view
that supports
range
synchronization,
select a new
range.

Time range is
updated. Manual

Selection is

highlighted. If the

most left time

(TT) of selected

time range is

outside the

current range,

then time range is

updated to

include it Manual

Manual

Doesn't really work
well you see both
trace in the tree, but
when you check
element it is not the
right color and both
trace show the same
data

LTTng 2.0 - I/O analysis

Fixed Bug 558203
https://bugs.
eclipse.
org/bugs/show_bug
.cgi?id=558203
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Target:

Step

0.1

0.2

0.3

0.4

Section
LTTng 2.0 - VM

Analysis

(moved to

Incubator)

Test Case Action

Prerequisites
Download
traces here:
https:

/Isecretaire.
dorsal.polymtl.
ca/~gbastien/tra
cingSummit201
4/mpi_traces.
tgz and import
the 3 kernel
traces in the
Import traces vmnet directory

Create an
Create experiment with
experiment the 3 traces in it

Synchronize the
experiment, it
should be
accurate and 2
Synchronize of the traces will
experiment be udpated

Right-click the
experiment,
click "Select
experiment
type..." and
select "Virtual

Set experiment Machine

type Experiment"

View

management

Verification

Comment

Comment

LTTng 2.0 - VM analysis
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1.1

1.2

1.3

1.4

1.6

2.1

Analysis
present

Open
experiment

Open view

Close view

Unapplicable
experiment
View
population

Populate the
view with
experiment

Expand the
Views element
of the
experiment

Open the vm
experiment in
Project Explorer

Expand the
Views element,
then the Virtual
Machine
analysis and
click on the
Virtual CPU
View

Close the
Virtual CPU
View

Open an
experiment that
is not of Virtual
Machine
Experiment type

With the VM
experiment,
open the Virtual
CPU View

The Virtual
Machine
Analysis is
present
Expand the
Views element
under the trace,
then the Virtual
Machine
Analysis
element. The
Virtual CPU
view is present

Virtual CPU
view is opened,
the virtual
machine
analysis is
triggered and
the view gets
filled

Virtual CPU
view is closed

Expand the
Views element
under the trace.
There is no
Virtual Machine
Analysis.

The view is
populated with
the VM element
as the only
parent and 2
virtual guests
having 3
VCPUs each
and a collapsed
Threads entries

Manual

Manual

Manual

Manual

Manual

Manual

N/A

N/A

N/A

N/A

N/A

N/A

LTTng 2.0 - VM analysis

VM experiment and normal experiment need visual differenciators.

launches kernel exec graph which take a very long time, slow indexing throughput

django exp
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2.2

2.3

24

2.5

3.1

View guest's
threads

VM specific
states

Preempted
thread states

Re-opening
Mouse handling

Drag move time
range

Expand the

A list of
processes is
shown, in
numerical order
and their time

Threads entry of graph viewer

a guest

Zoom in the
VCPUs time
graph around
the "interesting"
region, where
there is more
action (around
the second half
of the trace)

Select a region
with the
CPU_PREEMP
TED state and
scroll down the
threads entries
to around 405-
406: mpi-
imbalance
processes

Close the VM
experiment,
reopen it

Ctrl-Drag move
time graph left
and right with
middle button

part is filled

2 new states
are easily
recognizable:
WAIT_VMM
and
VCPU_PREEM
PTED

We can observe
alpha'ed states
corresponding
to the cpu
preempted
states

The view is
populated again

Time range is
dragged. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.

Manual

Manual

Manual

Manual

Manual

N/A

N/A

N/A

N/A

N/A

LTTng 2.0 - VM analysis
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3.2

3.3

3.4

3.5

Zoom time
range (mouse
wheel)

Zoom time
range (mouse
drag)

Mouse vertical
scroll

Vertical scroll
bar

Zoom with
mouse wheel up
and down,
cursor inside
time graph while
holding the Ctl
button

Drag in time
graph scale left
and right with
left button

Scroll with
mouse wheel up
and down,
cursor outside
time graph

Click and drag
vertical scroll
bar

Time range is
zoomed in and
out, relative to
Mouse Cursor.
When mouse
wheel is
stopped for a
short time,
states are
updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Table and time
graph scroll up
and down and
remain aligned.
Selected worker
does not
change. Vertical
scroll bar
updated.

Table and time
graph scroll up
and down and
remain aligned.
Selected
process does
not change.

Manual

Manual

Manual

Manual

N/A

N/A

N/A

N/A

LTTng 2.0 - VM analysis
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Drag select time

3.6 range
Double-click
3.7 reset time range

Mouse hover
3.8 (empty region)

Mouse hover

3.9 (state)
Drag mouse
3.10 selection

Drag select time
graph with right
button

Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, states
are updated and
new time range
is propagated to
other views. Manual N/A

Time range is

reset to full

range, states

are updated and

new time range

is propagated to

other views. Manual N/A

Tool tip shows
process name
only. Manual N/A

Tool tip shows entry

name, state name,

date, start time, end

time, duration. Manual N/A

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative) Manual N/A

LTTng 2.0 - VM analysis
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Click select with
left button
(begin time),
press shift key
and click select

Shift key another time
3.1 selection (end time)
Keyboard
4 handling
Keyboard With focus on
navigation in table, use UP,
table (process DOWN, HOME,
4.1 selection) END keys
With focus on table,
in Windows use
LEFT, RIGHT keys
while expandable
element is selected
Keyboard
navigation in in Linux use SHIFT
LEFT, RIGHT keys
table (tr.ee while expandable
4.2 expansion) element is selected
Keyboard With focus on
navigation in time graph, use
time graph UP, DOWN,
(process HOME, END
4.3 selection) keys
Keyboard With focus on
navigation in time graph, use
time graph LEFT, RIGHT
4.4 (state selection) keys
Tool bar
5 handling

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative) Manual

Selected entry

is changed.

Time graph

selection is

updated.

Vertical scroll

bar updated. Manual

For expandable

element, tree is

expanded or

collapsed. Time

graph item expansion

is updated. Vertical

scroll bar updated.

For other entries, it

does nothing. Manual

Selected entry is

changed. Table

selection is updated.

Vertical scroll bar

updated. Manual
Previous or next

state is

selected.

Selected time is

updated in other

views. Manual

N/A

N/A

N/A

N/A

N/A

LTTng 2.0 - VM analysis

99



5.3.0-TraceCompassTestCases

5.1

5.2

5.3

5.4

5.5

5.6

Align views

Show Legend

Reset Time
Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Click on the Align
View Button, with
another time graph
view, eg the Control
Flow view opened
above or under

Click Show
Legend button

Click Reset
Time Scale
button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom
In/Out button

When it is pressed,
moving the line
between tree viewer
and time graph will
move the line of the
other view. If not
pressed, the line can
be moved without
affecting the other
views

The legend
dialog is opened
and can be
closed.

Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.
Previous or next
state is
selected.
Selected time is
updated in other
views.

Selected entry
is changed in
table and time
graph. Vertical
scroll bar
updated.

Time range is
zoomed in and
out, relative to
center of
selection or
window. States
are updated and
new time range
is propagated to
other views.

Manual

Manual

Manual

Manual

Manual

Manual

N/A

N/A

N/A

N/A

N/A

N/A

Verified in Aug. 15-
2018 at 16:27PM

State works

LTTng 2.0 - VM analysis
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57 Add Bookmark
5.8 Next/Previous marker
5.9 Delete bookmark
5.1 Do not show markers
512 Show markers
6 Synchronization
Time
6.1 synchronization
Window range
6.2 synchronization

Select a time, and
click on the Add
Bookmark button

Add more
bookmarks, then click
on the next/previous
marker buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark
button

Click on the down
arrow at the extreme
right of the view, then
expand Show
markers and uncheck
the Bookmarks box

Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

Select a new window
range in another view

The bookmark is

added and is

displayed in the other

views as well (if

enabled) Manual N/A

The time graph view
navigate between the
bookmarks, States
are updated and time
selection is
propagated to other
views. When on a
bookmark, the Add
bookmark buttons
changes to Delete
bookmark Manual N/A

The bookmark is
deleted from all views Manual N/A

All remaining

bookmarks disappear

from the view, but

remain in other views

where the they are

enabled Manual N/A

The bookmarks come
back Manual N/A

Selected time
line is updated.
If selected time
is outside
current range,
time range is

updated to

include it. Manual N/A
Window range

is updated. Manual N/A

LTTng 2.0 - VM analysis
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6.3

In any other
view that
supports
selection range
synchronization,
Selection range select a new
synchronization range.

Selection is

highlighted. If

the left time (T1)

of selected time

range is outside

the current

range, then

window range is

updated to

include it Manual N/A

LTTng 2.0 - VM analysis
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Section Pass Fail To Do Comment
Flame Graph 11 0 1
Target:
Step Test Case Action Verification Comment
0 Download the test resources Download this
1 .Preparation |

Use menu
Window — Show Verify that 'Flame
View — Tracing Graph View' view
1.1 Open TMF Flame Graph View — Flame Graph is shown SWTBot

Import a trace

that does not have

any call stack

information, like Verify that

a standard kernel nothing is shown

1.2 Import generic trace trace in the view SWTBot
Verify that the
Flame Graph
Import the trace  View is populated
in the "trace" with some
directory of the  callers/callees
1.3 Import cyg-profile trace downloaded zip  information. SWTBot
Verify that the
Flame Graph
Import a trace in  View is populated
the "trace-fast"  with some
directory of the  callers/callees
1.4 Import cyg-profile-fast trace downloaded zip  information. SWTBot
2 | Manage View
Flame Graph'
Close the 'Flame view is removed
2.1 Close view Graph' View from perspective SWTBot
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2.2

23

2.4

2.5

2.6

2.7

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Restart

Close all traces

Use menu
Window — Show
View — Other ...
— Tracing —
Flame Graph

Open "trace(-
fast)" trace

1) Close 'Flame
Graph' view

2) Open
"glxgears-cyg-
profile(-fast)"
trace located in
the git in ctf test
3) Open 'Flame
Graph' view
Open Experiment
with 2 or
moreFlame Graph
traces.

(You can use both
traces)

Restart Eclipse
with Flame Graph
trace opened

Close traces and
experiment one
by one from the
editor tab

Flame Graph'
view is displayed
and re-populated
Verify that view
is populated with
callers/callees
information

Verify that view
is populated with
callers/callees
information

Verify that view
is populated with
all callers/callees
information
(separated by
trace).

Verify that view
is populated with
callers/callees
from trace

Verify that Flame
Graph view is
cleared after
closing the last
trace

SWTBot

SWTBot

SWTBot

Manual name

Manual

Manual

FlameGraphView

parent traces have no = Automation

Candidate

Automation
Candidate
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3.1 Thread name sorting
3.2 Thead id sorting

4.1 Time synchronization
4.2 Go to maximum

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or

moreFlame Graph

traces. Then
select 'Sort
threads by thread
name'

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or

moreFlame Graph

traces. Then
select 'Sort
threads by thread
id'

Select a random
time in another
view

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
maximum'

The view is
sorted by thread
name. Manual

The view is
sorted by thread
id. Manual

Selected time line

is not updating.

Nothing happen. Manual
- The 'Call Stack'

view is populated

- The call stack

view is

synchronised to

the range of the

maximum call

duration of the

'Flame Graph'

selected entry Manual

FlameGraphView

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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43 Go to minimum
5.1 Function name import
5.1 Mouse hover (empty region)

Mouse hover (state)

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
minimum'

1. Open the 'Call
Stack' view with
the 'Flame Graph'
view and the cyg-
profile trace
opened

2. Import 'cyg-
profile-mapping.
txt' as mapping
text file

Hover mouse in
time graph over
empty region

Hover mouse in
time graph over
state

- The 'Call Stack’

view is populated

- The call stack

view is

synchronised to

the range of the

minimum call

duration of the

'Flame Graph'

selected entry Manual

Both 'Call Stack'

and 'Flame Graph'

views display

function name

instead of

function address. SWTBot

Tool tip shows
depth only SWTBot

Tool tip shows

Total time and

self times with

standard

statistics. SWTBot

FlameGraphView

Automation
Candidate
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Target:

Section

Counters View

Pass

Fail

To Do
0

Comment
0

CountersView

Step

1

1.1

[ 5]

2.1

1]

3.1

4.1

wn

5.1

Test Case

Preparation

Import an LTTng trace (with counters)
and non LTTng traces

Filtered checkbox tree
Same as 1.1

Displaying counters data
Same as 1.1

Supporting experiments
Same as 1.1

Persistence between traces

Action

LTTng trace (with counters): kernel VM in test-traces

Same as above

Same as above

Same as above

Verification

In the project explorer, ensure the Counters view icon is only
strikethroughed for the non LTTng trace.

The color is changed when filtering the counters

All counters are displayed

All counters are displayed

Manua

Manual

Manual

Manual

Pass

Pass

Pass

Pass

N/A

Comment
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Section # Bug Reports # Open # Fixed
Bug Reports 0 0 0
Test Case Bug Title Found Bug Report Status
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